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NOT ALL EGI SYSTEM OR SOFTWARE PRODUCTS OR FEATURES ARE AVAILABLE FOR 
PURCHASE OR USE IN ALL COUNTRIES OR MARKETS. The sale of medical devices is strictly 
regulated by national laws. This manual is not an offer to sell a medical device in any country 
where its sale would be prohibited by national law.  For the current regulatory clearance 
status of EGI products in your country, go to www.egi.com/company/certificationscompany.  

RESEARCH USE ONLY in U.S.   
The following EGI products, including variants, are 
sold for strictly research purposes and are not 
medical devices in the United States, including 
software that is not a “software as a medical device” 
(SaMD). As such, these products cannot be used for 
medical purposes such as the diagnosis, treatment, 
cure, mitigation, or prevention of diseases. 

 Amp Server™ Pro SDK software 
 Field Isolation Containment System (FICS) 

enclosure* for the amplifier  
(RESEARCH USE ONLY for EEG-fMRI) 

 GeoScan™ 1.0 Sensor Digitization System 
 Geodesic EEG System™ 400 MR  series of 

systems (GES 400 MRs) 
 GeoSource™ v3.0 to v3.1 Research software 
 Geodesic Transcranial Electrical 

Neuromodulation™ 100 Research system 
(GTEN 100 Research system) 

 Net Amps GTEN 100 amplifiers** 

CE marked in Europe  
The following EGI products, including 
variants, are CE marked in conformity with 
the European Medical Device Directive. 

 HydroCel Geodesic Sensor Nets™ (GSNs) 
 MicroCel Geodesic Sensor Nets™ (GSNs) 
 Field Isolation Containment System (FICS) 

enclosure for the amplifier (for EEG-fMRI) 
 Geodesic EEG System™ 400 series of 

systems (GES 400s) 
 Geodesic EEG System™ 400 MR series of 

systems (GES 400 MRs) 
 Geodesic Photogrammetry System™ (GPS) 
 GeoSource™ 2.0 software (Available for 

clinical use in the U.S. as a SaMD.) 
 Net Amps™ 400 series (NA 400s) 

amplifiers** 

* Allowed for non-fMRI uses. For details, refer to the GES 400 series manual (8100400) and/or contact EGI Technical Support (Table P-2). 

** Due to the resulting change in configuration, any EGI amplifier that is upgraded to a Net Amps GTEN 100 amplifier (as a 
part of a GTEN 100 system upgrade) loses its certification as a cleared medical device, and any system it operates within is also 
no longer certified.  
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Key changes in this revision: 

Preface: Clarified the key differences between Basic, Intermediate, and 
Advanced. 

Section 1.1: Updated the intended use statement. 
Section 2.1: Updated the system requirements. 
Chapter 4: Clarified the differences between atlas head models and CAHMs and 

IHMs. Also, clarified the differences between the FDA-cleared 
GeoSource 2.0 versus the for-research-use-only GeoSource 3.1 Research. 

Chapter 7: Updated the MIP’s head modeling to clarify the four stages. 
Chapters 9 and 10: Updated for minor software changes. 
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Preface 
elcome to the GeoSource™ 3.1 
Research (Basic, Intermediate, 

and Advanced) electrical source 
estimation software from Electrical 
Geodesics, Inc. (EGI). The GeoSource
software extends the abilities of 
EGI’s Net Station™ EEG acquisition, 
review, and analysis software to the 
imaging of electrical sources.  

The source results from GeoSource 3.1 Research are viewable in the 
Reciprocity™ Visualization Environment (RVE), which is accessed from 
within Net Station Review. The RVE is where you will 
explore the finite difference method (FDM) head 
models and view the forward projections of scalp 
voltage data from any region of the cortex.

  

For GeoSource 3.1 Research Intermediate or Advanced, 
you will also use the Modal Image Pipeline™ (MIP) software module to 
create conformal atlas head models (CAHMs) and/or individual head 
models (IHMs).  

 

WARNING: Source estimation refers to methods that are employed for 
estimating the current sources of scalp recorded EEG. There are two classes 
of methods: linear and nonlinear. Each class employs different approaches to 
source estimation, which is an ill-posed problem. In the nonlinear class are 
methods that employ equivalent dipoles, and in the linear class are methods 
that employ different constraints applied to a minimum norm solution. 
Because source estimation is an ill-posed problem, there are no unique 
answers. Therefore, estimates of current sources from scalp recorded EEG 
data, whether they are derived from linear or nonlinear techniques, are 
approximate, and should always be viewed in the context of the scalp data 
by a trained reviewer. 

W 



10 GeoSource 3 Research User Manual  |  8103101-54  2017-05-16  |  FOR RESEARCH USE ONLY

FDA-cleared GeoSource 2.0 versus GeoSource 33..11  RR eesseeaarrcchh  

Every GeoSource 33..11  RR eesseeaarrcchh* license, for research use only, also includes 
a license for the clinically FDA-cleared GeoSource 2.0.  

 Be aware that any source waveforms created using GeoSource 33 .. 11   
RR ee ss ee aa rr cc hh  are restricted to research use only. 

 Note that a source montage in the FDA-cleared GeoSource 2.0 is the same 
as a source collection in GeoSource 33..11  RR eesseeaarrcchh .  

* GeoSource 3.1 Research Intermediate includes Basic and  
  GeoSource 3.1 Research Advanced includes Intermediate and Basic. 

The three packages of GeoSource 3.1 Research provide the following 
functionalities. 

GeoSource 3.1 Research Basic: 

 Uses inverse techniques 
to calculate estimations 
of source locations in the 
brain from dense array 
EEG data (up to 256 
channels) that was 
measured on the scalp 
with EGI’s HydroCel or 
MicroCel Geodesic Sensor 
Net™ (GSN) and recorded 
into a Net Station 
EEG .mff file.  

 Extracts the current 
values needed for statistical analyses using the Statistic 
Extraction waveform tool from Net Station Tools. 

Basic provides: 

Six atlas head models 
three adult 
three pediatric 

Three RVE views 
EEG Data Exploration 
Head Model Review 
Source Estimate Review (Triples) 

3D topo maps  

Custom source collections 

Custom dipole source groups 

Cannot use the MIP’s outputs 
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GeoSource 3.1 Research Intermediate:  

 Provides all the 
functionality of Basic.  

 Plus, warps conformal 
atlas head models 
(CAHMs) to digitized 
sensor positions. 

GeoSource 3.1 Research Advanced: 

 Provides all the 
functionality of Basic and
Intermediate.  

 Plus, utilizes individual 
head models (IHMs) that 
were created with 
imported MRI scans. 

 

For articles that address various procedural and theory aspects of EEG source 
estimation, click the Training and Technical Support tab at www.egi.com.  

 The Type tab provides articles by: 

− application advice (usage, best practices, workflows, etc.) 
− technical/troubleshooting/help advice 
− implementation theory of features and functions 
− theoretical background of dEEG, source estimation, and 

neuromodulation, etc. 

 The Products tab provides articles by product group.  

 The Manuals tab provides product manuals by product group. 

 The Video Tutorials tab provides product and instruction videos. 

Intermediate provides: 

All of Basic’s features, plus: 

Uses the MIP’s conformal atlas 
head model (CAHM) outputs 

Advanced provides: 

All of Intermediate’s features, 
plus: 

One additional RVE view 
Source Estimate Review (Oriented) 

Uses both of the MIP’s outputs 
conformal atlas head models 
(CAHMs)
individual head models (IHMs)
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Table P-1. Parts list for typical GES 400 series systems, including the GeoSource software 
GES systems are expandable. Your system components will be specific to your purchased configuration. 

Part Qty Mfr Mfr P/N EGI P/N 

NOT ALL SYSTEM OR SOFTWARE FEATURES ARE AVAILABLE FOR PURCHASE OR USE IN ALL 
COUNTRIES OR MARKETS. Refer to www.egi.com/company/certificationscompany.  

For all safety and use conditions for using your EGI system, refer to the manuals and 
instructions that shipped with your system configuration. 

Core components—Software 
Contains the Net Station Acquisition, Net Station Review, and Net Station Tools modules. 

Net Station (NS) 5.4 1 EGI  variant dependent 
HASP key 1 Safenet YWRGC variant dependent 

Core components—Amplifier 
Contains Amp Server™, the software that controls, collects, and publishes data from the amplifier to NS. 

Net Amps 400 
(NA 400) 

1 EGI  

4608880 (256 chs) 
4606168 (128 chs) 
4606358 (64 chs) 
4603285 (32 chs) 

Not available in China 

Net Amps 405 (NA 405) 
with D-sub connector to connect to HydroCel GSN G Nets 

4603293 (32 chs) 

Net Amps 410 
(NA 410) 

4608884 (256 chs) 
4606172 (128 chs) 
4606362 (64 chs) 
4603289 (32 chs) 

Net Amps GTEN 100 (NA GTEN 100) – 
RREESSEEAARRCCHH  UUSSEE  OONNLLYY 4609000 (256 chs) 

Core components—Misc. 

Articulated Arm for GSNs 1 EGI  
4605256 (256 chs) 
4605128 (128 chs) 

Computer, monitor, keyboard, mouse: 
iMac or laptop 1 Apple current model current model 

Ethernet switch 1 Black Box LGB2008A-R2 6156366 

Power supply  
availability** 

GES External Power Supply 
1 EGI  

4603988 
EGI External Power Supply 100 4603990 

Isolation transformer 1 Toroid ISB-060M 6156331 

Accessory components—Sensor Array 
Most Geodesic Sensor Nets (GSNs) have a modular Hypertronics connector. 

HydroCel GSN G Nets, however, have a D-sub connector and connect only to the Net Amps 405 amplifier. 
HydroCel GSN 1 or more EGI  variant dependent 
MicroCel GSN 1 or more EGI  variant dependent 
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Part Qty Mfr Mfr P/N EGI P/N 

Optional components 
Amp Server™ Pro SDK 2.0 – RREESSEEAARRCCHH  UUSSEE  OONNLLYY 1 EGI  4602003 

AV Device Kit 1 EGI  4601418 
AV Device DIN Adapter 1 EGI  4609786 

Carts 1 EGI  
4601100 (small) 
4607100 (large) 

EGI External Battery Pack 1 EGI  4605312 
Field Isolation Containment System (FICS) 

Allowed for non-fMRI uses* 1 EGI  
4609069 (256 chs) 
4602986 (128 chs) 

RREESSEEAARRCCHH  UUSSEE  OONNLLYY  ffoorr  EEEEGG--ffMMRRII  iinn  tthhee  UU..SS.. 

Clock sync  
availability** 

GES Clock Sync I/O 
1 EGI  

4608295 
GES Clock Sync I/O 4608296 

Geodesic Photogrammetry System (GPS) 1 EGI  4601900 
GeoScan 1.0 – RREESSEEAARRCCHH  UUSSEE  OONNLLYY 1 EGI  4609761 

GeoSource 2.0 – FDA-cleared for clinical use 1 EGI  variant dependent 
GeoSource 3.1 Research – RREESSEEAARRCCHH  UUSSEE  OONNLLYY 1 EGI  variant dependent 

GSN Interface Cable (GSNIC) 1 EGI  
4606256 (256 chs) 
4606128 (128 chs) 

Photic Stimulator 1 EGI  4609125 
Physio16 1 or 2 EGI  4609271 

Physio16 MR – RREESSEEAARRCCHH  UUSSEE  OONNLLYY 1 or 2 EGI  4609272 
Response Pad 1 EGI  4608150 

Documentation 
GSN user instructions (i.e., placards) differ per GSN variant—HydroCel or MicroCel and routine or LTM. 

AV Device Kit manual 1 EGI  S-MAN-200-AV-001 

Computer, monitor, keyboard, mouse: 
iMac or laptop 

For all safety and use conditions for using the computer that is 
shipped with your EGI system, refer to third-party manufacturer 

manuals at https://support.apple.com/country-selector/manuals. 

GeoScan 1.0 manual – RREESSEEAARRCCHH  UUSSEE  OONNLLYY 1 EGI  8100550 
GeoSource 2.0 manual – 

FDA-cleared for clinical use 1 EGI  8103101-52 

GeoSource 3.1 Research manual – RREESSEEAARRCCHH  UUSSEE  OONNLLYY 1 EGI  8103101-53+ 
GES 400 manual 1 EGI  8100400 

GES 400 MR manual – RREESSEEAARRCCHH  UUSSEE  OONNLLYY 1 EGI  8100401 
GSN manual 1 EGI  8105171 

GTEN 100 Research manual – RREESSEEAARRCCHH  UUSSEE  OONNLLYY 1 EGI  8102120 
Net Station manual 1 EGI  8100050 
Routine EEG placard 1 EGI  variant dependent 

LTM EEG placard 1 EGI  variant dependent 
Preterm Infant placard 1 EGI  variant dependent 

* For details, refer to the GES 400 series manual (8100400) and/or contact EGI Technical Support (Table P-2). 
** Changeover between equivalent component model/variants is due to parts availability. 
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Typical GES System 
The Net Station software operates within EGI’s GES systems to acquire 
EEG data from a single Net Amps amplifier, to acquire EEG data from 
more than one amplifier, or to acquire simultaneous data from two 
different signal sources.  

 
Figure P-1. Core components of a typical EEG-only GES system  
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About This Manual 
This manual provides general information for safely and effectively 
using the GeoSource software to estimate electrical sources in EEG 
data and the MIP software module to create conformal atlas and 
individual head models. It assumes a working proficiency with EEG, 
head modeling, source localization, and computer systems.  

Note that the term patient is used to refer to subjects, participants, or patients. 

An EGI support or authorized engineer will install and configure your EGI system, 
including all connections required for its operation. At the time of initial 
installation, the EGI support or authorized engineer will also train relevant staff in 
its operation. At any time you have additional questions or wish retraining, contact 
EGI Technical Support (Table P-2). 

Typographic conventions: 
 Italics are used for definitions or newly introduced terms. 

 Boldface italics are used for important concepts or for special 
emphasis. 

Boldface is used for command paths (for example, File > Open).

Warnings, Cautions, and Notes 
The following are used to convey important information: 

 

WARNING: Warnings provide important information that, if 
unheeded, could result in serious physical injury, death, or 
equipment damage. 

 

CAUTION: Cautions provide important information that, if 
unheeded, could hinder the use of a product, feature, or procedure, 
or result in physical injury or equipment failure. 

Note: Notes provide clarifying information about a product, feature, or procedure. 
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Support, Repairs, and Documentation

Electronic copies of EGI’s user manuals and instructions are available 
for download at www.egi.com/knowledge-center or from the Training 
and Technical Support tab at www.egi.com. 

If you have a question, please: 

 For urgent issues during acquisition, contact EGI immediately.  

 For nonurgent issues, do the following before contacting EGI: 

– Isolate the problem.  
Try to repeat and define the problem. 

– Document the problem.  
Carefully record the sequential details of the problem. 

– Report the defined problem.  
Contact EGI.  

Table P-2. EGI contact information 

EGI Technical Support web page www.egi.com/knowledge-center 

Email Technical Support supportteam@egi.com  

Email Sales orderdesk@egi.com
Telephone +1.541.687.7962 

Fax +1.541.687.7963 
Address Electrical Geodesics, Inc. (EGI) 

500 E 4th Avenue, Suite 200 
Eugene, OR 97401  
USA  
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1. Safety and Use 
Conditions 

For all safety and use conditions for using your EGI system, refer to the manuals 
and instructions that shipped with your system configuration. 

Do not operate your GES system, including the GeoSource and/or MIP 
software, until you are fully trained and understand all warnings, 
cautions, and conditions for use provided in EGI’s manuals for the 
components of your GES system. If you have any questions, contact EGI 
Technical Support (Table P-2). 

 

WARNING: All EGI system components must be installed and 
configured by an EGI support or authorized engineer. Deviating 
from the supported configuration or running the system with non-
EGI-approved components attached can cause hazards or 
unexpected performance. 

Note that the information in this manual is subject to change, without notice. The 
manufacturer declines responsibility for the safety, reliability, and performance of EGI 
system components if not used in compliance with EGI documentation. 

1.1 Intended Use 
As an optional component of the GES 400 family of EEG devices, the 
GeoSource 3.1 Research software is intended to: 

 Visualize human brain function via imaging the electrical 
sources in EEG data with rendered images of an idealized head 
model and an idealized MRI image.  
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 Be used with the Modal Image Pipeline (MIP) software module 
that creates conformal atlas head models (CAHMs) and 
individual head models (IHMs). 

 Be used with adults, children, and infants.  
 Be used by a trained clinician or doctor. 
 Provide data that may be used by a trained clinician or doctor 

to aid in the diagnosis of epilepsy and other related 
neurological disorders. 

 Be used with no restrictions on patient population that may 
be treated. 

 Be used with no contraindications for use. 
 Regarding Geodesic Sensor Nets (GSNs), these accessory 

devices are not recommended with non-intact skin. 

For research use only.  Rx only. For indoor use only. 

1.2 Features  
GeoSource 3.1 Research is available in three packages:  

 Basic — provides six built-in atlas head models (three adult, 
two pediatric, and one infant) 

 Intermediate — creates conformal atlas head models (CAHMs) 
using digitized sensor positions to conform/warp an atlas head 
model to individual head geometry 

 Advanced — creates individual head models (IHMs) using 
imported MRI scans 

Each license provides features depending upon the package 
purchased and includes: 

 High-resolution, dense array EEG with up to 256 channels 

 Fast, step-by-step head model building 

 More realistic head models with seven characterized tissue types 
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More realistic electrical conductivity modeling using the finite 
difference method (FDM) 

 LORETA, sLORETA, and LAURA constraint methods 

 FDM head models built from 1 mm resolution MRI data 

 Intermediate and Advanced provide a GPU-accelerated 
computer for generating lead field matrices (LFMs) 

1.3 Safety Warnings 

1.3.1 Computer and OS X 

 

CAUTION: Before upgrading your EGI system (computer, operating 
system, or EGI software), confirm compatibility with EGI Technical 
Support (Table P-2). 

1.3.2 Reviewing and Manipulating EEG Data 

 

CAUTION: Vary file names within the first 22 characters. When 
exporting data to text files, Net Station truncates file names longer 
than 22 characters. If truncated file names are identical, they may 
overwrite each other 
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2. Software 
EGI protects its software from unauthorized use by encoding the licensing data in a 
HASP key (similar to a USB flash drive). All authorized EGI software users have a HASP 
key that plugs into one of the USB ports of any EGI Mac OS system computer to allow 
access to the purchased applications licensed to that HASP key. 

2.1 System Requirements 
for GeoSource 3.1 Research 

Table 2-1. Software compatibilities 

GeoSource  Net Station Mac OS 

3.1 Research 
Intermediate and Advanced,  
include MIP and OsiriX MD 

5.4 
10.12.4 

10.11.6 

3.0 Research 
Intermediate and Advanced,  
include MIP and OsiriX MD 

5.3.0.x 10.11.5 

FDA-cleared 2.0 
5.3 and later corresponding 

5.2 10.10.5 

FDA-cleared 2.0 4.5.7 10.6.8 

To create conformal atlas head models (CAHMs) or individual head 
models (IHMs), the Modal Image Pipeline™ (MIP) will require 3D sensor 
position files from either of EGI’s sensor registration products: 

 Geodesic Photogrammetry System™ (GPS)  

 GeoScan™ sensor digitization system 
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The computer that runs GeoSource 3.1 Research and the MIP can be 
the same as the computer that is running Net Station 5.4 Review. 
However, a GPU-accelerated computer is required to generate lead 
field matrices for CAHMs or IHMs. 

Table 2-2. Hardware requirements 

EGI Mac Computer 
running: 

GeoSource 3.1 Research 
Net Station 5.4 

MIP (with OsiriX MD) 

GPU-accelerated Unix Computer 
generating: 

Lead field matrices (LFMs) 

 Mac OS X 10.11.6 or 10.12.4 
 Intel Core 2 Duo processor 

(2 GHz minimum) 
 16 GB RAM (minimum) 

Silicon Mechanics 4U Tower with: 

 Two GPUs – EVGA GeForce GTX 1080 TI 6 GB 
 Two Intel Xeon 8 Core processors [ 2.1 GHz 

(minimum) and 64 GB RAM (minimum)] 

2.2 Installation 
If the GeoSource and/or MIP software is purchased with a new system, it 
comes installed on the EGI system computer. If you need to download 
software purchased separately from a system or you need to reinstall the 
software, contact EGI Technical Support (Table P-2). 
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3. Source Estimation 
With a range of specification settings, GeoSource allows you to easily 
visualize and explore source activations represented in MRI and 
waveform views. These comparative source estimations allow you to 
draw educated conclusions.  

The solutions provided by GeoSource are approximations of the locations 
of sources that are responsible for generating the EEG that is recorded at 
the scalp. It is a good idea to use GeoSource solutions from different 
source-imaging specifications in conjunction with other EEG tools and the 
results from other imaging modalities to determine if the solutions are 
consistent with the recorded data.  

3.1 Parameters of Source Imaging 
Settings 

3.1.1 Generic Forward and Inverse Problems 

Source imaging involves solving a forward problem and an inverse 
problem. 
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In simple terms, the generic forward problem is: 

Given known source locations and propagation model, what are 
the surface measurements? 

The solution is then “flipped over” to solve the generic inverse problem, 
which is: 

Given a known topography on the scalp, what is the contribution 
of each dipole necessary to produce the topography? 

3.1.2 EEG Forward and Inverse Problems 

With GeoSource, you create source imaging specifications that 
combine the following components for solving the inverse problems 
based on defined forward solutions. 

 EEG sources (or source locations). Locations of possible 
current generators that might produce a dipole. 

 Forward head models. Models that describe the propagation of 
current through a conductive medium (i.e., the head). 

 Inverse models. Models that produce a unique answer from 
the infinite number of possible answers to the inverse problem. 

GeoSource estimates sources by combining: 

 a source-imaging specification, which contains forward and 
inverse models; and 

 EEG scalp data from a Net Station file. 

3.1.3 Forward Algorithms for EEG 

For a given set of source (i.e., dipole) locations, the geometry of the 
conductive media (i.e., shape of the brain, cerebrospinal fluid (CSF), 
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skull, and scalp), the conductivity of each media, and the location of 
EEG sensors on the scalp, we can calculate the voltage potential 
recorded by the EEG sensors for each source. This calculation is known 
as the lead-field calculation and may be performed using different 
assumptions (such as spheres for geometry). 

The resulting calculation is known as the forward matrix, which contains 
dipoles by EEG sensors. Note that because the number of sensors does 
not equal the number of dipoles, the forward matrix is nonsquare. 

In other words, the forward matrix models the electrophysics resulting 
from a dipole at a cortical location and the potential field that it 
generates throughout the head volume. 

GeoSource’s forward models for EEG are the: 

 Sun-Stok 4-shell sphere: A spherical head model used with 
atlas head models.  

 finite difference model (FDM): A realistic head model used 
with conformal atlas head models (CAHMs) and individual 
head models (IHMs). 

3.1.3.1 Spherical—Atlases Head Models only 

As an isotropic model, the spherical model consists of four shells that 
represent the brain, cerebrospinal fluid (CSF), skull, and scalp.  

Remember that isotropic models have identical conductivity in all directions. 



26 GeoSource 3 Research User Manual  |  8103101-54  2017-05-16  |  FOR RESEARCH USE ONLY

Following are the geometry and their conductivity values: 

Shell Radii 
(cm) 

Radial 
conductivity 

(siemens per 
meter [S/m]) 

Tangential 
conductivity 

(siemens per 
meter [S/m]) 

Spherical Shells 

Scalp (σ4) 7.5 0.33 0.33 

 

Skull (σ3) 7.1 0.0042 0.0042 

CSF (σ2) 6.5 1 1 

Brain (σ1) 6.3 0.33 0.33 

3.1.3.2 Finite Difference Method (FDM)—CAHMs and IHMs  

A finite difference 
method (FDM) is a 
realistic 3D 
representation of  
the head. In GeoSource, 
the FDM is based on a 
realistic MRI and uses 
an isotropic model of 
tissue conductivities. 

Remember that isotropic 
models have identical 
conductivity  
in all directions. 

Shell Radii 
(cm) 

Conductivity 
(siemens per meter [S/m]) 

Brain (σ1) 8.0 
0.35 (WM)

0.25 (GM) 

CSF (σ2) 8.2 1.79 

Skull (σ3) 8.7 
0.010 (age 2+) 

0.036 (age 0-2) 

Scalp (σ4) 9.2 0.33

Eyeballs   1.55 

Conductivity values for the FDM model (Ferre, et al., 2000) 
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3.1.4 Dipoles 

In each forward head model, the cortex is tessellated into small units 
to define source locations. Each source location is defined as a possible 
current generator that could produce a dipole. Each dipole location 
has a location and an orientation. 

For IHMs, dipole locations are defined as patches of cortex. Each dipole is 
oriented in one direction, perpendicular (normal) to the cortical surface. 

For atlases, dipole locations are defined as 3D voxels. Each dipole 
consists of three orthogonal orientations representing X, Y, and Z. 

Within the RVE, GeoSource allows you to view each dipole location 
(cortical patch or 3D voxel) and the orientations associated with each 
dipole in a 3D head model. 

When viewing source waveforms, GeoSource allows you to view all 
three orientations for each dipole (as overlaid source waveform 
components) or as one collapsed waveform that represents the RMS 
(root mean square) of the three orientations combined (as RMS of 
source waveform components). 

3.1.5 EEG Sources (or Source Locations) 

GeoSource offers a dense set 
of dipole locations.  

Depending upon the atlas, 
the sources in the FDM 
consist of 958 to 2,447 
dipoles distributed 
throughout the gray matter.  

Remember that: 

 Each dipole (EEG source 

Atlas 
Number of 

Dipoles 

2 mm Atlas Man 2,447 

0-2 year male 958 

2-9 year male 1,463 

9-18 year female 1,745 

32 year male 1,732 

40 year male 1,721 

45 year female 1,720 

Oriented example 2,384 
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or source location) is a cortical location of a current generator that is capable 
of producing a dipole.  

 Atlas head models display dipoles as 3D voxels, whereas individual head 
models display dipoles as cortical patches. See section 3.1.4. 

This dipole set produces a nonsquare forward matrix. When a nonsquare 
forward matrix is inverted using a pseudoinverse, the solution is either 
underdetermined or overdetermined. 

3.1.5.1 Underdetermined and Overdetermined Solutions 

An underdetermined solution 
exists when there are more 
dipole sources than EEG sensors 
(in mathematical terminology, 
more unknowns than equations). 
MNLS is used by GeoSource 
when the solution is 
underdetermined. 

An overdetermined solution exists 
when there are more EEG sensors 
than dipole sources (more  
equations than unknowns). 

3.1.6 Minimum Norm Least Squares (MNLS) 

Least squares is a mathematical process that finds the best-fitting curve 
to a set of points by minimizing the sum of the squares of the offsets of 
the points from the curve. The result is an infinite number of possible 
least-squares solutions. Minimum norm captures a unique solution by 
choosing the one that uses the least amount of energy. 
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3.1.6.1 Weighting 

The MNLS technique, used by GeoSource when the solution is 
underdetermined, produces a unique solution because only one 
combination of sources can simultaneously explain the data and be of 
lowest overall intensity. Weaker and more localized solutions are favored 
because less activity is required to explain the measured data and, 
consequently, deeper sources are often “incorrectly” projected on the 
surface, which means that the MNLS technique has a superficial bias. 

3.1.7 Methods (constraint schemes) 

GeoSource provides three source-imaging specification methods for 
solving the inverse problem to overcome the superficial bias of the 
MNLS technique. 

LAURA (local autoregressive average). The LAURA method is based on 
biophysical laws. According to electromagnetic theory, the 
strength of the source falls off with the inverse of the cubic 
distance for vector fields and with the inverse of the squared 
distance for potential fields. 

LAURA constrains a solution based on two factors:  

(1) The theory that the strength of a dipole decreases as the 
distance from the source increases.  

(2) The local autoregressive average of coefficients that depend 
on the distance between solution points.  

The weighting is based on the mean of norms of all three sources 
(X, Y, and Z) at each dipole location.  

The constraint is based on the closest neighbors for each location, 
and the falloff is proportional to the inverse of the distance cubed. 
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For further information, please reference: 

 Grave de Peralta Menendez, R., Gonzalez Andino, S.L., Lantz, G., Michel, C.M., & 
Landis, T. (2001). Noninvasive localization of electromagnetic epileptic activity. I. 
Method descriptions and simulations. Brain Topogr, 14, 131–137. 

 Grave de Peralta, R., & Gonzalez, Andino, S. (2002). Comparison of algorithms 
for the localization of focal sources: Evaluation with simulated data and 
analysis of experimental data. International Journal of Bioelectromagnetism, 
online journal. 

 Grave de Peralta, R., Murray, M.M., Michel, C.M., Martuzzi, R., & Gonzalez, 
Andino S. (2004a). Electrical neuroimaging based on biophysical constraints. 
Neuroimage, 21:527–39. 

LORETA (low-resolution brain electromagnetic tomography). The LORETA 
method assumes that physiological properties act as constraints to 
the depth weighting in the minimum norm algorithm. Specifically, 
this scheme assumes that the activity in neurons in neighboring 
patches of cortex is related and selects the solution with the 
smoothest spatial distribution by minimizing the Laplacian of the 
weighted sources, which is a measure of spatial roughness. This 
results in a rather “blurred” solution. The weighting is based on the 
norm of all three sources (X, Y, and Z) at each dipole location. 

For further information, please reference: 

 Pascual-Marqui, R.D. (1999). Review of methods for solving the EEG inverse 
problem. International Journal of Bioelectromagnetism, 1: 75-86. 

 Pascual-Marqui, R.D., Michel, C.M., & Lehmann, D. (1994). Low resolution 
electromagnetic tomography: a new method for localizing electrical activity in 
the brain. International Journal of Psychophysiology, 18: 49-65. 

sLORETA (standardized low-resolution brain electromagnetic 
tomography). The sLORETA method also assumes that physiological 
properties act as constraints to the depth weighting in the minimum 
norm algorithm. The difference between sLORETA and LORETA, 
however, is that sLORETA selects the solution that standardizes the 
source current density such that there is equal sensitivity for deep 
and superficial sources. 
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For further information, please reference: 

 Pascual-Marqui, R.D. (2002). Standardized low resolution brain electromagnetic 
tomography (sLORETA): technical details. Methods & Findings in Experimental & 
Clinical Pharmacology, 24D:5-12. 

3.1.8 Suggested Reading 

 Ferre, T.C., Eriksen, K.J., and Tucker, D.M. (2000). Regional head tissue conductivity 
estimation for improved EEG analysis. IEEE Transactions on Biomedical Engineering, 
47(12), 1584–1592. 

 Gorodnitsky, I.F., George, J.S., & Rao, B.D. (1995). Neuromagnetic source imaging with 
FOCUSS: A recursive weighted minimum norm algorithm. Electroencephalography and 
Clinical Neurophysiology, 95, 231–251. 

 Grave de Peralta, R., & Gonzalez Andino, S. (2002). Comparison of algorithms for the 
localization of focal sources: Evaluation with simulated data and analysis of 
experimental data. International Journal of Bioelectromagnetism, online journal. 

 Lemieux, L., McBride, A., & Hand, J.W. (1996). Calculation of electrical potentials on the 
surface of a realistic head model by finite differences. Physics in Medicine and Biology, 
41, 1079–1091. 

 Michel, C.M, Murray, M.M., Lantz, G., Gonzalez, S., Spinelli, L., & Grave de Peralta, R. 
(2004). EEG source imaging. Clinical Neurophysiology, 115(10), 2195– 2222. 

 Neumaier, A. (1998). Solving ill-conditioned and singular linear systems: A tutorial on 
regularization. SIAM Review, 40, 636–666. 

 Pascual-Marqui, R.D. (1991). Review of methods for solving the EEG inverse problem. 
International Journal of Bioelectromagnetism, 1, 75–86. 

 Song, J., Morgan, K., Turovets, S., Li, K., Davey, C., Govyadinov, P., . . . Tucker, D. M. 
(2103). Anatomically accurate head models and their derivatives for dense array EEG 
source localization. Functional Neurology, Rehabilitation, and Ergonomics, 3, 275-293.  

 Sun, M. (1997). An efficient algorithm for computing multishell spherical volume 
conductor models in EEG dipole source localization. IEEE Transactions on Biomedical 
Engineering, 44(12), 1243–1252. 
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3.2 Available GeoSource Parameters 
Whether you are viewing GeoSource data using the GeoSource specifi-
cation tool, Waveform viewer, MRI viewer, or RVE viewer, the method, 
regularization, computation model, and head model parameters apply.  

For details about the GeoSource specification tool, see chapter 5. 

For details about the Waveform, MRI, and RVE viewers, see chapter 4. 

 
Figure 3-1. General GeoSource parameters via Net Station Tools and Net Station Review 
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3.2.1 Method 

GeoSource provides three source-imaging specification methods for 
constraining the inverse problem: LAURA, LORETA, and sLORETA. 

LAURA (local autoregressive average). The LAURA method is based on 
the 26 closest neighbors for each location. 

LORETA (low-resolution brain electromagnetic tomography). The 
LORETA method selects the solution with the smoothest spatial 
distribution.  

sLORETA (standardized low-resolution brain electromagnetic 
tomography). For IHMs, the sLORETA method standardizes the 
source current density such that there is equal sensitivity for deep 
and superficial sources. 

3.2.2 Regularization 

GeoSource allows for the broadening of information to stabilize an 
ill-posed problem. By stabilizing the solution, small variations in the 
data are prevented from leading to large variations in the 
distribution of activity in the source solution. This forces additional 
smoothness to the constraints on the final source estimation and 
reduces the effects of noise. 

Whereas values of 0 to 10-9 are available to regularize the inverse 
model, values of 10-2 to 10-4 are suitable for most data. 

3.2.3 Computation Model 

GeoSource provides two forward-head computation models to define 
the geometry of the head tissues: spherical and FDM. 
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Spherical. For atlas head models, the spherical model consists of 
four shells representing the cortex, cerebrospinal fluid (CSF), 
skull, and scalp. 

Finite Difference Model (FDM). For CAHMs and IHMS, the FDM 
model captures the typical geometry of the human head tissues, 
including the cortex, cerebrospinal fluid (CSF), skull, and scalp. 

3.2.4 Built-in Atlas Head Models 

GeoSource 3.1 Research provides six built-in, 1 mm resolution atlas 
head models that were built from MR and CT scans of average brains 
using the FDM.  

Because the FDA-cleared GeoSource 2.0 product is included with 
purchases of the GeoSource 3.1 Research product, you also have 
access to the FDA-cleared 2 mm Atlas Man head model for continued 
use for those who wish it.  

FDA-cleared GeoSource 2.0 versus GeoSource 33..11  RR eesseeaarrcchh  

Every GeoSource 33..11  RR eesseeaa rrcchh* license, for research use only, also includes 
a license for the clinically FDA-cleared GeoSource 2.0.  

 Be aware that any source waveforms created using GeoSource 33 .. 11   
RR ee ss ee aa rr cc hh  are restricted to research use only. 

 Note that a source montage in the FDA-cleared GeoSource 2.0 is the same 
as a source collection in GeoSource 33..11  RR eesseeaarrcchh .  

* GeoSource 3.1 Research Intermediate includes Basic and  
  GeoSource 3.1 Research Advanced includes Intermediate and Basic. 

Each atlas head model has a defined dipole set. 

RESEARCH USE ONLY. For the research-use-only GeoSource 3.1 
Research, the six built-in atlas head models were developed from 
the skull and scalp of one individual and the averaged brain of 
many individuals (based on MNI average brains).  
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The same brain was used for all three adult atlases and age-
appropriate brains were used for the infant/pediatric atlases. (For 
the 0-2 year atlas, the brain came from the University of North 
Carolina, instead of MNI.) 

After the brains were put 
into the individual skull and 
scalp anatomy, to get the 
average head shape for 
each atlas, the skull and 
scalp were warped to the 
HydroCel GSN average 
point cloud for each age 
group. 

For a full description of the 
creation details for the six age- 
and gender-specific FDM atlas head models of GeoSource 3.1 Research, refer to: 

Song, J., Morgan, K., Turovets, S., Li, K., Davey, C., Govyadinov, P., . . . Tucker, D. M. 
(2103). Anatomically accurate head models and their derivatives for dense array 
EEG source localization. Functional Neurology, Rehabilitation, and Ergonomics, 3, 
275-293.  

FDA cleared for clinical use. For the FDA-cleared GeoSource 2.0, 
the 2 mm Atlas Man head model has a dipole set that contains 
2,447 dipoles distributed across general regions of the cortex. 
Each dipole is represented as a triple regional source made up 
of three dipoles in the X, Y, and Z orientations. 

The set for the 2 mm Atlas Man head model represents the Montreal 
Neurological Institute’s (MNI) average MRI specification of brain tissue, which is 
derived from the average of 305 subjects. This average MRI specification is well 
represented in scientific literature for use with functional brain imaging data, 
such as fMRI, and was created to be representative of a generalized population 
(239 M, 66 F, age 23.4 +/- 4.1). Information about the average MRI and its use in 
the scientific literature can be viewed at: http://imaging.mrc-
cbu.cam.ac.uk/imaging/MniTalairach. 

Atlas 
Number of 

Dipoles 

2 mm Atlas Man 2,447 

0-2 year male 958 

2-9 year male 1,463 

9-18 year female 1,745 

32 year male 1,732 

40 year male 1,721 

45 year female 1,720 

Oriented example 2,384 
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3.2.5 Source Collections 

GeoSource 3.1 Research provides six built-in source collections in the 
form of its six atlases. The power of GeoSource 3.1 Research, however, 
is in creating custom source collections from custom head models. 
Using conformal atlas head models (CAHMs) with GeoSource 3.1 
Research Intermediate or using CAHMs or individual head models 
(IHMs) with GeoSource 3.1 Research Advanced in the Reciprocity 
Visualization Environment (RVE), you can create more accurate source 
collections within your scalp EEG data.  

3.2.6 Waveforms  

For individual head models (IHMs), source waveforms represent current 
density information for one-directional, oriented dipoles. 

For atlases, including conformal atlas head models (CAHMs), 
GeoSource provides two ways to view current density information 
using source waveforms: component and RMS. 

Component Waveforms. The component option displays source 
waveforms as three separate waveforms—one for each dipole in a 
separately labeled track, such as 1x, 1y, 1z, 2x, 2y, 2z, etc.  

 

RMS Waveform. The RMS option displays source waveforms collapsed 
into a single waveform.  
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3.2.7 RMS Computation Order—GeoSource Tool only 

GeoSource provides options for the RMS Computation Order setting 
only if the Waveforms setting is set to RMS Waveform. The available 
options are: ‘Average dipoles, then RMS components’ and ‘RMS 
components, then average dipoles’.  

Average dipoles, then RMS components. To take orientation into 
account, this option takes the mean of each vector orientation (i.e., 
the mean of all Xs, the mean of all Ys, and the mean of all Zs), and 
then takes the RMS at the end. 

RMS components, then average dipoles. To take the magnitude of 
each dipole triple into account, this option takes the RMS of the 
vector strengths of each dipole triple first, and then takes the 
average across the group. 
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4. 3D Visualization 
While working with the GeoSource 3.1 Research software (Basic, Inter- 
mediate, or Advanced), you will work seamlessly between the Reciprocity 
Visualization Environment (RVE) and Net Station 5.4 Review.  

The RVE provides you with vivid visualizations and 3D source 
localizations of your EEG scalp data. See Table 4-1. 

FDA-cleared GeoSource 2.0 versus GeoSource 33..11  RR eesseeaarrcchh  

RREESSEEAARRCCHH  UUSSEE  OONNLLYY..  Be aware that any source waveforms created using 
GeoSource 33..11  RR eesseeaarrcchh  are restricted to research use only. 

Note that a source montage in the FDA-cleared GeoSource 2.0 is the same as a 
source collection in GeoSource 33..11  RR eesseeaarrcchh . 

Table 4-1. General functionalities of EGI’s interoperable software applications 

EGI Software Function 

Net Station 5.4 

Acquisition, Review, and Tools 

 Acquires, reviews, and exports EEG data. 
 Saves EEG data to MFF files.  
 Provides the link between EEG data and 3D 

head models in the RVE. 

GeoSource 3.1 Research 

Basic, Intermediate, or Advanced 
 Estimates electrical sources. 
 Displays source estimations in the RVE. 

Reciprocity Visualization 
Environment 

(RVE) 

 

 With or without GeoSource 3.1 Research: 
shows 3D topo maps. 

 With any level of GeoSource 3.1 Research: 
shows 3D advanced visualization of your EEG data. 

 With Basic or Intermediate GeoSource 3.1 
Research: displays 2D MRI slices of the 
corresponding cortical source estimations. 

 Displays source intensities with 3D topo maps 
and 3D head models of your EEG data 
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EGI Software Function 

 

RVE cont’d 

generated from a variety of views, including: 

 With any level of GeoSource 3.1 Research: 
scalp topography 

 With Basic and Intermediate:  
atlas triples dipoles 

 With Advanced: 
individual oriented dipoles  

Modal Image Pipeline (MIP) 
used only with GeoSource 3.1 

Research Intermediate or Advanced 

 Creates conformal atlas head models (CAHM). 
 Creates individual head models (IHMs). 

What you see in the RVE depends upon what type of data you are 
viewing. See Table 4-2. 

Table 4-2. RVE functionality, depending upon other licensed software 

Net Station 5.4 Review, 
GeoSource (FDA-cleared 2.0 and 3.1 Research), 

and MIP 

Reciprocity Visualization 
Environment (RVE) 

Net Station 5.4 Review 

with GeoSource 2.0                                

The RVE is not available when using GeoSource 2.0. 
GeoSource 2.0 files open only with the MRI Viewer 
from Net Station Review, which provides access to: 

 2 mm Atlas Man head model  
 2D MR slice view with highlighted sources 
 all GeoSource 2.0 features 

 

Net Station 5.4 Review 

with no version of GeoSource                          

Review provides access to the RVE, even when no 
version of GeoSource is licensed.  

With no licensed version of 
GeoSource, the RVE provides 

only 
3D topo maps for review. 
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Net Station 5.4 Review, 
GeoSource (FDA-cleared 2.0 and 3.1 Research), 

and MIP 

Reciprocity Visualization 
Environment (RVE) 

Net Station 5.4 Review 

With GeoSource 3.1 Research 
Basic,  

the RVE provides: 

 3D topo maps 
 Triples dipole sources 
 Custom source collections  
 Custom dipole source 

groups 

with GeoSource 3.1 Research Basic 
 

Review provides access to the RVE, while  
GeoSource 3.1 Research Basic provides access  
to the following in the RVE: 

 Three views: 
− EEG Data Exploration 

− Head Model Review 
− Source Estimate 

Review (Triples)  

 Six atlas head 
models: 
− Three adult atlases 

− Three pediatric atlases 
 MRI slices 

 Cannot use MIP outputs. 

Modal Image Pipeline (MIP) 
For GeoSource 3.1 Research Intermediate, the MIP creates Conformal Atlas Head Models (CAHMs). 

Net Station 5.4 Review With GeoSource 3.1 Research 
Intermediate,  

the RVE provides: 

 3D topo maps 
 Triples dipole sources 
 Custom source collections  
 Custom dipole source 

groups 

with GeoSource 3.1 Research Intermediate  
 

 Includes all of Basic’s features, plus: 

 Uses the MIP’s Conformal Atlas Head Model 
(CAHM) outputs 
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Net Station 5.4 Review, 
GeoSource (FDA-cleared 2.0 and 3.1 Research), 

and MIP 

Reciprocity Visualization 
Environment (RVE) 

Modal Image Pipeline (MIP) 
For GeoSource 3.1 Research Advanced, the MIP creates Conformal Atlas Head Models (CAHMs) and 

Individual Head Models (IHMs). 

Net Station 5.4 Review 
With GeoSource 3.1 Research 

Advanced,  
the RVE provides: 

 3D topo maps 
 Oriented dipole sources 
 Custom source collections  
 Custom dipole source 

groups 

with GeoSource 3.1 Research Advanced 
 

 Includes all of Intermediate’s features, plus: 
 Provides one additional view 
− Source Estimate Review (Oriented) 

 Uses both of the MIP’s outputs: 
− Conformal Atlas Head Models (CAHMs) 
− Individual Head Models (IHM) 

4.1 RVE Viewer 
Depending upon what you want to do with your data, 
you will launch the RVE Viewer either from inside Net 
Station Review or from Finder > Applications > EGI 
> Net Station 5. Select the RVE icon from either place.  

Opening the RVE from Finder > Applications allows 
you to open any head model directly into the Reciprocity Viewer. 
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4.1.1 Launched from Net Station Review  

Table 4-3. Reciprocity’s available launching options from Net Station Review 

Methods 
Regularization 

Values 
Computational 

Models 
Head Models 

3D Topo Maps 

 

Not applicable Not applicable 

Built-in atlases: 

 three adult 
 three 

pediatric 

LAURA* 

 

10 – 10-9 

(10-3 is the default.) 

Spherical / 
FDM 

(FDM is the default.) 

Built-in atlases: 

 three adult 

 three 
pediatric 

LORETA* 

 

10 – 10-9 

(10-3 is the default.) 

Spherical / 
FDM 

(FDM is the default.) 

Built-in atlases: 

 three adult 

 three 
pediatric 

sLORETA** 

 

10 – 10-9 

(10-2 is the default.) 

Spherical / 
FDM 

(FDM is the default.) 

Built-in atlases: 

 three adult 

 three 
pediatric 

*Also appropriate for conformal atlas head models (CAHMs). 
**Also appropriate for individual head models (IHMs). 
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4.1.1.1 Chart View as Display Controller of the RVE 

While you are exploring your source EEG data, be aware that the 
display of EEG data in the RVE is controlled by the settings made in the 
Chart view of Net Station Review. 

If, however, you switch views between montages that use different 
references (for example, HydroCel GSN 256 1.0 to an Average 
Reference), the RVE will re-reference the scalp (electrode) EEG data. 

If, however, you switch between montages that do not include the 
same number of channels (for example, a 10-10 montage to a 10-20 
montage), the RVE will display the maximum number of sensors in the 
Net and EEG data (that is, 256, 128, 64, or 32) on the 3D head model. 

4.1.2 Launched From Finder > Applications 

Accessing the RVE as a standalone application provides the features for 
visualizing CAHMs and IHMs in GeoSource 3.1 Research Intermediate or 
Advanced and/or creating neuromodulation protocols with GTEN 
Planning.  

For details about the Geodesic Transcranial Electrical Neuromodulation™ (GTEN™) 100 
Research system, refer to the GTEN 100 Research manual (8102120). 

When launched as a standalone application, the Reciprocity Viewer 
provides most of the features as when launched from Net Station 
Review, except for source localization—there are no GeoSource 
settings for method, regularization, computation model, or head 
model when launched from Finder.  

Note that source localization with all of Reciprocity’s 3D source estimation and 
visualization features requires that you access your EEG data from Net Station Review. 
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To launch the RVE and visualize a head model: 

➊ Launch the RVE from 
Applications > EGI > 
Net Station 5 > 
Reciprocity.  

 

 

 

 
 

➋ Open a head model by clicking File > Open Head Model. 
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4.2 RVE’s Menus 

Standard menus operate as expected. Reciprocity-specific menus are 
described here. 

Reciprocity. About gives you the version number of your copy of the 
RVE and Quit allows you to quit the application (or, you can click 
the red close button).  

File. Use these menu options to open, export, close, or switch 
between opened head models. Also export dipoles. 

When the RVE is launched from the Finder, remember that you 
have no source localization features for a file in the RVE. If you 
need to use the source localization features, you must launch the 
RVE from within Net Station Review. See section 4.1. 

View. Use these menu options to set views to a particular angle of the 
head, toggle color bars, etc. 

For additional controls that create source collections, view GeoSource 
and topographic data, and increase the visibility of areas of interest in 
head models, see sections 4.3.2, 4.3.4, 4.3.5, and 4.3.6. 
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Windows. Use these menu options to show/hide the five panes of the 
RVE window.  

GTEN Planning. The GTEN Planning menu is described in the 
GTEN 100 Research manual (8102120).  

4.3 RVE’s Window, Features, and Controls  

Not all features are available in all versions of the software. If you have any 
questions, contact EGI Technical Support (Table P-2). 

 

Figure 4-1. Features and controls of the RVE window 
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4.3.1 Available Views 

Depending upon which version of GeoSource you have a license for 
(the FDA-cleared GeoSource 2.0 or the Basic, Intermediate, or 
Advanced level of GeoSource 3.1 Research), different views will be 
available to you in the RVE.

After the RVE opens, either from Net 
Station Review or Finder > Applications, 
the RVE provides a selection of views to 
facilitate your further research or 
clinical research work. 

Remember that EEG data displayed in the RVE is 
controlled by the settings made in the Chart 
view of Net Station Review. See section 4.1.1.1. 

Table 4-4. Available views 

Callout View Description

 EEG Data 
Exploration 

Scalp Topography Exploration. This is the 3D topo 
map view that is selected as a Method from Net 
Station Review.  

 
Head Model 
Review 
Aside from any 
GeoSource 3.1 
Research or 
GTEN 100 Research 
uses, these views 
are useful for 
verifying electrical 
head models. 

GPS Image Review. This view shows how well EEG 
sensor positions are registered to CAHMs and IHMs.  

 Tissue Segmentation Review. This view shows how 
well tissue classifications are characterized. 

 Atlas Electrophysics Review. This view shows the 
forward leadfield projections of triples dipoles for 
built-in atlases and CAHMs. 

 Individual Electrophysics Review. This view shows the 
forward leadfield projections of oriented dipoles for 
IHMs.

 Source Estimate 
Review 
(Oriented) 

Individual Oriented Dipoles. This is a GeoSource 3.1 
Research Advanced view for IHMs.  
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Callout View Description 

 Source Estimate 
Review (Atlas) 

Atlas Triples Dipoles. This is a GeoSource 3.1 Research 
view for any atlas-based head model. 

 

GTEN 
Planning 

Individual GTEN Planning. Present with licensed 
optional software. Used to create modulation 
protocols with individual head models (IHMs). 

 Atlas GTEN Planning. Present with licensed optional 
software. Used to create modulation protocols with 
atlas and conformal atlas head models (CAHMs). 

4.3.1.1 Default Settings for Available Views 

The Available View buttons work as follows for all atlas and individual 
head models: 

 Click a view button once to display data in that view, starting 
with that view’s default settings. 

 Click the same view button again to reset that view to its 
default settings, at any time during your exploration. 

 Click another view’s button, and that view will display the data 
with its default settings.

 Zoom exception. All view settings reset to default, except for the 
zoom setting. Even if you are changing from one view to another, 
the zoom setting will remain as it was set in the previous view. 
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4.3.2 Source Collections 

You can create customized triples 
or oriented source collections 
within the RVE to display specific 
dipoles or dipole groups. 

Remember that: 

GeoSource 
2.0 = GeoSource  

3.1 Research 
source 

montage 
= 

source 
collections 

ROIs = 
dipole source 

groups 

In addition to creating dipole 
source groups from the Source 
Collections pane, you can select 
dipoles (voxels) manually.  

Table 4-5. Selecting dipoles (voxels)  

Method Keystrokes Descriptions

2D MRI Slices — Basic and Intermediate  

For use with:  

 Atlas and Conformal Atlas Head Models (CAHMs) 
 Triples Dipole Source Groups 
 Triples Source Collections 

 

Individual Shift + click Selects individual dipoles to populate a 
dipole source group. 

Radius Shift + click + drag Selects a group of dipoles within a drawn 
radius. 
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Method Keystrokes Descriptions 

Threshold Cmd (zz ) + click Selects the first dipole and then displays a 
dialog box to enter a threshold value for 
the automatic selection of additional 
dipoles that are connected to the first 
dipole. 

For example, a threshold of 50 entered for 
a dipole of 10 µA fills the dipole source 
group with dipoles that are within ± 50% 
(5-15 µA). 

Dynamic 
Threshold 

Cmd (zz ) + click + 
drag 

Selects the first dipole and then displays 
mouseover text of the threshold 
percentage value based upon the 
additional dipoles you select by dragging. 

3D Head Models — Advanced  

For use with:  

 Individual Head Models (IHMs) 
 Oriented Source Groups 

Oriented Source Collections
 

Patch Cmd (zz ) + click Selects patches of dipoles to populate a 
dipole source group. 

4.3.3 Patient Details 

The Patient Details pane in 
Reciprocity is linked  
to the Show/Hide  
Sensitive Info button  
in Net Station Review.  

You can change the  
display (show or hide)  
from Review or from Reciprocity by 
clicking View > Show 
[or Hide] Sensitive Info. 
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4.3.4 Function Controls—GeoSource and Topographies  

Following are the function controls that 
appear when viewing GeoSource and 
topographic data.  

Table 4-6. Function controls for GeoSource and 
Topography views 

Callout Control Description 

 Snap to 
Maximum 

Centers the crosshairs to the location of the maximum 
(or highest) dipole intensity. 

Checkbox. When checked, the crosshairs will 
automatically snap to the location with the 
highest dipole intensity as you continue to move 
through the data. 

Button. When the checkbox is unchecked, the button 
is still available to selectively snap the crosshairs to 
the highest dipole intensity. 

 Scalp 
Voltage Field 

Provides buttons to view scalp voltage data as scalp 
EEG categories or dipole source group projections. 
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Callout Control Description 

 EEG 
Category 

Shows the category currently being displayed, which is 
the category selected in Net Station Review and linked 
to the RVE.  

If multiple categories (as with overlaid segments) are 
being displayed in Net Station Review, use this selector 
to choose which category is displayed in the RVE. 

Source 
Threshold 

Displays more or fewer of the source results based on a 
percentage of threshold values for dipole intensity. 
Depending upon the selected threshold: 

 A higher percentage displays a wider range of 
dipole intensities, including all of the highest 
values (and colors) and gradually fewer of the 
lower values (and colors). 

 A lower percentage displays a narrower range of 
dipole intensities, including far fewer or none of 
the lower value intensities, but still showing most 
or all the highest valued dipole intensities. 

   
 threshold 0% threshold 16% threshold 68% 

 Source 
Opacity 

Adjusts the transparency of the displayed source data. 

 Show Dipole 
Details 

For a category range, 
lists all dipoles and their 
values and colors.  

This dialog can be 
sorted and used to 
navigate (jump) to 
specific locations.  

Any view, except 3D topo maps, will show dipole 
details. 
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Callout Control Description 

 Imaging 
Spec 

Shows the Model Type, Method, and Regularization a file 
was launched with.  

To see a head model with other imaging specifications, 
go back into Net Station Review, click the RVE button 
again, and launch another RVE window for the same 
head model, but with different imaging specification 
parameters. The second RVE scene will show the same 
head model with different parameters that are linked 
to the same EEG data in Review.  

With multiple RVE windows open for the same head 
model (with different parameters), the Imaging Spec 
fields become active so that you can change the 
parameters for the active head model (that is, the Active 
Scene). 

 

Note that only two head models can be open at the same time 
and only four windows associated with each head model can 
be open. 

 Close 
Current Spec 

When multiple head models and imaging specifications 
are loaded into the RVE, this button closes the active 
imaging specification.  

When only one head model and imaging specification 
is open, this button closes the RVE completely. 

Note that two head models can be open at the same time, and 
each head model can have up to four imaging specifications 
open with it. To switch between multiple open head models, 
click File > Switch Head Model. 
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Callout Control Description 

 Intensity 
color 
controls 

Minimum and Maximum pickers. Upon first 
displaying a file, these pickers display the default 
minimum (right picker) and default maximum (left 
picker) intensities. You can adjust these as desired.  

Intensities color bar. Graphically shows the intensities 
shown by the pickers.  

Lock Color Range. When checked, the minimum and 
maximum, as well as the spectrum palette, are 
locked, regardless of the time point changing. 
When unchecked, the minimum and maximum 
values will update as the current time point 
changes in the data.  

You can use these controls to make spatially discrete areas more obvious: 

 Reduce the maximum picker value by 20% to highlight the higher 
intensity voxels. 

 Reduce the number of low-intensity voxels that are showing by raising the 
minimum picker value. 

 Filters Shows the values of the lowpass, highpass, and notch 
filters as set in the file.

4.3.5 Function Controls—GTEN Planning Plugin  

The Function Controls of the GTEN 
Planning Plugin are described in the 
GTEN 100 Research manual (8102120).  
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4.3.6 View Controls  

The View controls increase the 
visibility of areas of interest in 
head models.  

Not all view controls 
appear for all types of 

head models. 

Table 4-7. View controls (some are not available for all views) 

Callout Control Description 

 Cortical 
Meshes 

Shows/hides the left and/or right hemispheres.  

 Scalp Mesh Indicates the head surface. 

Opacity slider. Adjusts the transparency of the scalp 
mesh. 

 EEG 
Electrodes 

Indicates the location of the EEG sensors across the 
head surface. 

Size slider. Adjusts the size of the displayed EEG 
sensors. 

Show Leadfields (X, Y, and Z). For triples dipoles with 
three vectors (X, Y, and Z), these buttons change 
the leadfield projection to the stated direction (X, 
Y, or Z) and displays only this projection. 

 MR Image 
Volume 

Indicates dipole intensities.  

Opacity slider. Adjusts the transparency of the 
segmentation overlay that is on top of the 
MRI slices. 
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4.3.7 Head Model Pane 

Depending upon whether you are creating source data files with 
GeoSource 3.1 Research or creating modulation protocols with GTEN 100 
Research, the 3D head model pane is used to display EEG data and source 
results or to create dipole source groups and source collections.

The left 3D head model is an actual cortical fold view and the right 3D 
head model is an inflated cortical fold view.  

To navigate within the 3D images, refer to the keyboard shortcuts given in section 4.4. 

4.3.8 MRI Slices  

The MRI slices of the RVE visualize the brain in one of two ways: 

 MRI brain, when viewing individual head models (IHMs) with 
oriented dipoles, or 

 voxelated brain, when viewing atlas head models, including 
conformal atlas head models (CAHMs) with triples dipoles. 

For details about voxels and dipoles, see section 3.1. 

actual cortical 
fold view 

inflated cortical 
fold view 
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4.3.8.1 MRI Brain – showing oriented dipoles 

For individual head models (IHMs), the MRI slice panes display individual 
head geometry, such as tissue segmentation and cortical surface.  

For IHMs, dipoles are oriented, which means they are one-directional and oriented 
perpendicular to the cortical surface. 

MRI brain slices 
showing head geometry 

corresponding 3D head model 
showing oriented dipoles over 

actual cortical folds on the left and 
inflated cortical folds on the right 
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4.3.8.2 Voxelated Brain – showing triples dipoles 

For atlas head models, including CAHMs, the MRI slice panes display 
dipole intensities overlaid onto sagittal, coronal, and axial MRI slices.  

For atlases, dipoles are approximately represented by voxels, which are colored 3D 
volume pixels. Specifically, a single, colored dipole cube represents 7 voxels cubed. As 
a basic volume unit in the MRI slices, a dipole of 7 voxels x 7 voxels x 7 voxels is 
resampled in .egia files as 1 mm x 1 mm x 1mm. 

The slice sliders navigate to a specific slice in the 
corresponding pane (sagittal, coronal, or axial). As they 
do, the other two slice panes will update accordingly. 

The grid numbers used in GeoSource do not correspond 
to Talairach Daemon or MNI coordinates. 

voxelated brain MRI slices 
showing triples dipoles 

corresponding 3D head model 
showing a topo map over 

actual cortical folds on the left and 
showing all dipoles over 

inflated cortical folds on the right 
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4.4 3D Image and 2D Slice Shortcuts 
The keyboard shortcut mappings available for GeoSource 3.1 Research 
in the RVE allow you to easily rotate, zoom, move, and navigate 3D 
images and 2D MRI slices. 

Table 4-8. 3D image and 2D slice keyboard shortcuts for GeoSource 3.1 Research in the RVE 

Mode Function Keys 

2D slice 

Zoom Right-click + drag 

Move Shift + right-click + drag 

MRI slice navigation Left-click + drag 

Brightness Cmd (z) + right-click + drag óó  

Contrast Cmd (z) + right-click + drag ôô  

3D image 

Zoom Right-click + drag 

Move Shift + right-click + drag 

Rotate Left-click + drag 
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5. GeoSource Tools 
and Source Results 

Whereas both the RVE and the GeoSource tool perform source 
estimation on EEG data: 

 You can only visualize source results in the RVE.  

Note that you must have opened the RVE from Net Station Review to be 
linked to the EEG data file. 

 You create source data files containing source waveform 
results with GeoSource tools from within Net Station Tools. 
These files have “_nsw” appended to their names.  

With these files, you can: 

 View source waveform results in Net Station Review using 
the GeoSource Waveform viewer. 

 Use the Statistic Extraction tool to extract the current 
values you need to perform statistical analysis. 

For details, refer to Appendix C, “Net Station’s Tools,” of the Net Station 5 
manual (8100050). 

The GeoSource tool may be specified differently for different evaluations, such 
as clinical research, interictal, or classic ERP. Even for the same evaluation, the 
tool may be specified with different parameters to better explore the data.  

GeoSource will localize all scalp-recorded activity to dipoles distributed 
across the cortical grey matter. It is, therefore, important for the scalp 
data to be as artifact free as possible. This is accomplished through 
careful data acquisition followed by postprocessing to identify and 
correct/remove artifact-contaminated trials and channels.  
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Common workflows (clinical research, interictal, classic ERP, etc.) containing 
different tools and settings are available from EGI Technical Support 
(Table P-2). 

To specify a GeoSource specification tool, do the following: 

1. Know where your session data files are. 

In this example, the three session data files are titled VTD_00X and 
the folder they are in is titled VTD Processing.  

 

2. Open the Net Station Tools module of Net Station 5.  

3. Tool sets are optional but, if desired, click  ++  (plus) to make a 

new tool set.  
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4. If you created a new tool set, name it.  

In this example, change the untitled tool set to VTD Tools. 

5. Beside Create, select GeoSource as the tool to be specified.  
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6. A new GeoSource specification with default settings appears on 
the right. Type a name for this new specification (that is, this new 
tool) into the Specification Name field.

7. Under GeoSource Settings, set the fields as follows:  

 Method: LORETA  
 Regularization: 10-2  

Computation Model: FDM
 Head Model: 2 mm Atlas Man 
 Source Montage: 2 mm Atlas Man 
 Waveforms: RMS Waveform 
 RMS Computation Order: Average dipoles, then RMS 

components 
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RMS Computation Order—atlases only 

GeoSource provides the following options for the RMS Computation 
Order setting, when the Waveforms setting is set to RMS Waveform.  

Average dipoles, then RMS components. To take orientation into 
account, this option takes the mean of each vector orientation 
(i.e., the mean of all Xs, the mean of all Ys, and the mean of all Zs), 
and then takes the RMS at the end. 

RMS components, then average dipoles. To take the magnitude of 
each dipole triple into account, this option takes the RMS of the 
vector strengths of each dipole triple first, and then takes the 
average across the group. 

8. For this example, leave the Destination output Same As 
Source and click Create. This creates a tool that outputs files 
with automatically appended names (for GeoSource 
specification tools, “_nsw”), saved to the source file’s location. 

 
 

The GeoSource tool outputs source waveform files.  
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9. Notice that your 
new GeoSource tool 
appears in the Tools 
pane below the 
Tool Sets pane.  

As shown in the image, 
when estimating 
sources, you would 
normally explore your 
data with various 
versions of the 
GeoSource Tool to 
verify results. 

10. Drag your session files to the Input Files pane. 

Note that tools have been run successfully on up to 30 input files. 

11. If not done already, select (highlight) your new GeoSource 
tool in the Tools pane. 

Confirm you have selected the correct tool and that the specification 
settings are correct. 
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12. Click Run to process the files. Net Station will display the Job 
Queue and begin executing the selected tool. 

13. New _nsw.mff source data files will appear in the processing 
folder, which, in this case, also contains the .mff EEG data files. 
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14. Double-click your new source data files to open them in Net 
Station Review. Confirm the quality of the source results. 
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6. Defining Source 
Collections 

You will define dipole source groups from which to build your source 
collections. This chapter uses an oriented source collection as an 
example. 

When a source collection is created, only the voxels and the names of 
the dipole source groups that are included in the source collection are 
highlighted in the MRI panes of the RVE. 

Remember that a source montage in GeoSource 2.0 is the same as a source 
collection in GeoSource 3.1 Research. 

TRIPLES SOURCE COLLECTIONS (used with atlas and conformal atlas head 
models (CAHMs)): Notice that each dipole source group of a source collection 
is displayed as a composite dipole with three vectors. Also notice that the 
length of each vector indicates the intensity of the corresponding dipole’s 
orientation in the X, Y, and Z planes. The vectors point in the positive 
direction of the dipolar activity. In orthogonal slice views, only two of the 
three vectors are visible. For example, the coronal slice view shows vector 
orientation strengths in the X and Z directions. 

ORIENTED SOURCE COLLECTIONS (used with individual head models (IHMs): 
Dipoles of source groups and source collections are oriented perpendicular 
to the cortical surface. 

 

OBSERVATIONS: Observe the relationship between the source solution and 
the scalp topography. Look for brain regions and orientations that would 
volume conduct to produce your major scalp topographic features.  
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6.1 Manually Selecting Dipoles for 
Dipole Source Groups  

In GeoSource 3.1 Research’s 2D MRI Viewer, do the following to 
manually select dipoles for dipole source groups. 

Table 6-1. Selecting dipoles (voxels) for dipole source groups 

Method Keystrokes Descriptions

2D MRI Slices — Basic and Intermediate  

For use with:  

 Atlas and Conformal Atlas Head Models (CAHMs) 
 Triples Dipole Source Groups 
 Triples Source Collections 

Individual Shift + click Selects individual dipoles to populate a 
dipole source group. 

Radius Shift + click + drag Selects a group of dipoles within a drawn 
radius. 

Threshold Cmd (zz ) + click Selects the first dipole and then displays a 
dialog box to enter a threshold value for 
the automatic selection of additional 
dipoles that are connected to the first 
dipole. 

For example, a threshold of 50 entered for 
a dipole of 10 µA fills the dipole source 
group with dipoles that are within ± 50% 
(5-15 µA). 

Dynamic 
Threshold 

Cmd (zz ) + click + 
drag 

Selects the first dipole and then displays 
mouseover text of the threshold 
percentage value based upon the 
additional dipoles you select by dragging. 
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Method Keystrokes Descriptions 

3D Head Models — Advanced  

For use with:  

 Individual Head Models (IHMs) 
 Oriented Source Groups 
 Oriented Source Collections 

 

Patch Cmd (zz ) + click Selects patches of dipoles to populate a 
dipole source group. 

6.2 Defining Dipole Source Groups and 
Source Collections

➊ Select the relevant cortical surface 
dipole source(es). You can select 
one or more dipole sources.  

1. Click once to select a dipole 
source. 

2. Cmd+click to select multiple 
dipole sources. 

Selected dipole sources are outlined 
with a darker gray and display their 
directional dipole arrows. 

➋ Add these dipole source groups 
to a new group:  

1. Expand the Source Collections 
pane. 

2. Expand the Oriented 
Collections pane. 
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3. From the Add Selection drop-down box, select Add As New 
Group. 

4. In the following pop-up dialogs: 

a) Enter a unique source collection name. 

b) Enter a unique source group name. 

c) Select a unique source group color. 

5. After these selections, both the cortical surface image and the 
Source Collections pane will update with your parameters.  

 

 

6. To add additional dipole source 
groups, first,  
deselect (uncheck) all  
active groups.  

7. To add an individual dipole to an existing dipole source group:  

a) Click a dipole. 

b) From the Add Selection drop-down box, select Add To 
Existing Group. 

Source Collection Name 

Dipole Source 
Group Name 

Color 

New 

uncheck 
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c) Select a Dipole Source Group. The new dipole will take on 
the color of the assigned dipole source group. 

8. If desired, click Export Collection.  
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7. Head Modeling 
with MIP 

The Modal Image Pipeline™ (MIP) software from Electrical Geodesics, Inc. 
(EGI) is a separate application that is included with your GeoSource 3.1 
Research Intermediate or Advanced license. The MIP creates realistic 
conformal atlas head models (CAHMs) for Intermediate and Advanced, and 
creates individual head models (IHMs) for Advanced.  

When taken into GeoSource 3.1 Research, these more accurate head 
models improve the estimations of source locations from scalp EEG 
data. Among other uses, these more accurate head models are useful 
for deriving neuromodulation plans with GTEN 100 Research. 

For details, refer to the GTEN 100 Research manual (8102120). 

7.1 Identical Subject/Patient IDs 
In order to complete any head modeling and/or GTEN workflow, the 
subject/patient ID must be identical in all files used in the workflow. 
When it is not identical, the software will stop you with a warning 
message to correct the mismatch. 

Table 7-1. File types used to create head models or GTEN workflows 

Files CAHMs IHMs GTEN 

EEG (.mff) ✔✔  ✔✔   

Sensor coordinates (.gpsr or .sfp) ✔✔  ✔✔   

MR images (.egia)  ✔✔   

Head model (.gsrc)   ✔✔  

GTEN Planning (.mcb)   ✔✔  
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7.2 Processing 
The MIP software, to create conformal atlas and individual head 
models, uses a patented method that identifies seven different tissue 
types from MRI images:  

 white matter (WM) 
 grey matter (GM) 
 cerebrospinal fluid (CSF) 
 skull 
 scalp 
 eyeballs 
 air 

Based on the finite difference method (FDM) and using GPU-accelerated 
computing, the MIP software creates conformal atlas head models 
(CAHMs) in about 30 minutes and individual head models (IHMs) in 
about 90 minutes. 

These more accurate head models can then be taken into GeoSource 3.1 
Research (Intermediate and Advanced) for the estimation of source 
locations and into GTEN 100 Research for the creation of 
neuromodulation plans.  

Table 7-2. Required inputs to generate head models 

Head model MIP inputs GeoSource version 

Conformal Atlas Head 
Models (CAHMs) 

GPS .gpsr files 
or 

GeoScan .sfp files 

GeoSource 3.1 Research 
Intermediate and Advanced 

Individual Head 
Models (IHMs) 

MRI* files  
plus 

.sfp, .gpsr, or averaged** 

GeoSource 3.1 Research 
Advanced 

* For individual head models (IHMs), you will also use OsiriX MD to prepare your MRI 
files for entry into the MIP. 
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** An individual solved sensor position file (.sfp or .gpsr) is not required for the IHM 
workflow. You can use one of the built-in averaged sensor position files. However, be 
aware that these averaged files are not ideal for IHMs.  

7.2.1 Four Fundamental Stages 

The CAHM and IHM head models are created in four fundamental stages. 
The first three stages are processed by the MIP software on your EGI Mac 
system computer. The last stage, generating the LFM, is processed on your 
EGI GPU-accelerated computer. 

Stage 1—Tissue segmentation. The MIP’s 
algorithm first identifies the seven 
different tissue types directly from 
MRI scans. To estimate the skull 
tissue, which is not identifiable in the MRI data, an atlas skull is 
warped to the MRI identified tissue.  

This processing produces an anatomy.egia file. 

For CAHMs, stages 1 and 2 are calculated within the atlas head models; 
therefore, the creation of CAHMs starts with “stage 3.” 

Stage 2—Cortical surface extraction. The 
MIP software then creates 2,400 or 
4,800 dipoles (triples for CAHMs 
and oriented for IHMs) on a 
tessellated cortical surface.  

This stage produces a geometry.egig file. 

For CAHMs, stages 1 and 2 are calculated within the atlas head models; 
therefore, the creation of CAHMs starts with “stage 3.” 

Perform for IHMs, 
but not for CAHMs. 

Perform for IHMs, 
but not for CAHMs. 
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Stage 3—Sensor registration. The 3D sensor 
positions contained in either  
GeoScan’s .sfp files or GPS’s .gpsr files  
are used differently for CAHMs and IHMs.  

For CAHMs, the 3D sensor 
positions are used to warp a 
given atlas to an individual’s 
inferred geometry, which is 
based on the positions of EEG 
sensors that are completely 
covering the head.  

For IHMs, the 3D sensor 
positions are registered to the 
scalp model that was derived from an individual’s MRI. 

At the end of this stage, which is processed within the MIP, 
conductivity values are assigned to each tissue type before 
creating the bundled zip file that you will take into the GPU-
accelerated computer to generate the LFM. 

For both CAHMs and IHMs, this stage must be completed. 

Stage 4—Lead field matrix (LFM) generation. 
Using a GPU-accelerated computer,  
this last stage generates the lead field 
matrix (LFM) that relates how current 
from a given brain location (dipole) is propagated to the scalp and 
is recorded as voltage potentials at each EEG sensor position.  

For both CAHMs and IHMs, this stage must be completed.

Perform for both 
CAHMs and IHMs. 

Perform for both 
CAHMs and IHMs. 



GeoSource 3 Research User Manual  |  8103101-54  2017-05-16  |  FOR RESEARCH USE ONLY 79

 

Figure 7-1. MIP workflows for CAHMs and IHMs 
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7.2.2 Information Generated by MIP 

The MIP software creates the following information for GeoSource 3.1 
Research (Intermediate and Advanced). 

 MRI volume for visualization 

 Dipole locations for visualization and calculating 
source intensities 

 Surface meshes of the 
cerebral cortex 

one for each hemisphere for 
visualization in the Reciprocity 
Visualization Environment (RVE) 

 Inflated surface meshes  
of the cerebral cortex 
(only IHMs) 

one for each hemisphere for 
visualization in the RVE 

 Surface mesh of the scalp for visualization in the RVE 

 Lookup tables for the 
Talairach transformation 

to allow navigation in both native 
and Talairach coordinates 

 Lead field matrix (LFM) for calculating the source intensities 

7.2.3 How MIP Generates Information  

Through tissue segmentation, cortical surface extraction, and sensor 
orientation, a processed version of an MRI is created where every voxel 
is assigned a tissue type with known conductivities. 

Table 7-3. Default conductivities for the seven segmented tissue types 

Tissue Type Default Conductivities (S/m) 

White matter (WM) 0.35 

Grey matter (GM) 0.25 

Cerebrospinal fluid (CSF) 1.79 
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Tissue Type Default Conductivities (S/m) 

Skull  
age 2+ 0.010 

age 0-2 0.036 

Scalp 0.33 

Eyeballs 1.55 

Air 0.00 

This processing produces an anatomy.egia file. 

7.3 MIP’s Two Workflows 
The MIP software will guide users step-by-step through the tissue 
segmentation, cortical surface extraction, and sensor registration 
stages of the MIP’s workflows for generating CAHMs and IHMs. These 
stages are processed on your Mac computer. Stage 4 uses the GPU-
accelerated computer to generate LFMs.  

7.3.1 Conformal Atlas Head Model (CAHM)

A conformal atlas head model 
(CAHM) is created with an atlas 
when no MRI scan exists for a 
subject. This head model uses 
one of the pre-packaged, built-
in atlases (i.e., generalized head 
models) that are based on 
generalized age and gender.  

Since stages 1 and 2 (tissue 
segmentation and cortical 
surface extraction) are already 

Built-in Atlas Head Models 
Male pediatric atlas:  0 to 2 years 
Male pediatric atlas:  2 to 9 years 
Female pediatric atlas: 9 to 18 years
Male adult atlas:  32 years 
Male adult atlas:  40 years 
Female adult atlas:  45 years 

The MIP software will automatically 
suggest the closest match to the 
subject’s data, but you can change 
this selection as needed. 
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determined from the atlas head models, users need to complete only 
stages 3 and 4 (sensor registration and lead field generation). 

After a built-in atlas head model that is closest to the subject’s age and 
gender is selected, it is warped by the subject’s 3D sensor positions 
(from either a GeoScan .sfp file or a GPS .gpsr file), which acts as a 
geometrical target. 

For CAHMs, dipoles have three orthogonal orientations. 

7.3.2 Individual Head Model (IHM) 

An individual head model (IHM) can be created where an MRI scan 
exists for a subject. For IHMs, users will need to complete all four 
stages (tissue segmentation, cortical surface extraction, sensor 
registration, and lead field generation). 

For IHMs, dipoles are oriented perpendicular to the cortical surface.  

Higher Quality MRI Images 

Be aware that higher quality MRI images will: 

 Determine the quality of the IHMs created by the MIP. 

 Require less manual editing during MIP processing.  

To ensure that your MRI images are optimized for head modeling, see 
Appendix A (MRI Scanning Guidelines) and/or contact EGI Technical 
Support (Table P-2). 
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8. Creating CAHMs 
Creating conformal atlas head models (CAHMs) takes only about 
30 minutes, and the MIP steps you through the process. See Figure 8-1. 
You can complete stage 3 (sensor registration) on the same computer 
that is running Net Station Review. This workflow accepts solved 
sensor files (.sfp files from GeoScan or .gpsr files from GPS), but not 
averaged sensor position or other file formats. 

After you complete this processing, you will generate the lead field 
using the GPU-accelerated computer (see chapter 10). 

Remember that, for CAHMs, the tissue segmentation (stage 1) and cortical 
surface extraction (stage 2) are calculated within the atlas head models and 
not while creating the CAHMs. Therefore, creating CAHMs starts with stage 3. 

Figure 8-1. Stage 3 of the CAHM workflow (stages 1 and 2 are calculated within the atlas) 
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To complete stage 3 of the CAHM workflow, do the following: 

➊ Launch MIP from Finder/Applications/EGI/MIP/. 

➋ Select Create CAHM From 
Individual Sensors, for a 
CAHM head model, requiring 
an .sfp or .gpsr file. 

 

Note that the Load Existing Head Model option is used for reviewing a completed head 
model or resuming the processing of an incomplete head model. 

➌ Browse to select the .sfp or 
.gpsr file to use in creating 
the head model. 

 

➍ Type a prefix to append to  
the output file.  

This is required. 

 

➎ One of the six built-in atlas 
head models will be 
preselected based on the 
closest age and gender to  
that in the .sfp or .gpsr file. You 
can, however, reselect another.  

 

Male pediatric atlas – 0 to 2 years 
Male pediatric atlas – 2 to 9 years 
Female pediatric atlas – 9 to 18 years 

Male adult atlas – 32 years 
Male adult atlas – 40 years 
Female adult atlas – 45 years 
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This atlas will warp to the sensor locations and give a more accurate 
head geometry for all of the tissues in the resulting head model. 

➏ Wait for the MIP to open the GPS sensor registration window.  

This will take some minutes.  

➐ Adjust landmark points 
and ensure the sensors 
on the 3D head model 
(left pane) are placed 
exactly as in the net 
application photos 
(right pane). 

1. Click Landmarks. 

2. Manually adjust 
the seven points, 
if necessary. 

Landmarks screen 

 
Sensors screen 

Navigate in the 3D and 2D panes by: 

 Using the keyboard shortcut mappings (see section 4.4). 
 Selecting a camera in the GPS camera view field. 

Purpose of landmark points: 

Landmark points are what you use to adjust the individual sensors. 

When you move landmark points: 

 all sensors will move around the head; although 

 sensors closer to a moved landmark point will move relatively farther 
than sensors further away from the landmark point. 

You cannot move the individual sensors themselves. 
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How landmark points adjust individual sensors: 

1. Click the rraaddiioo  bbuuttttoonn of one of the seven landmarks, then either: 

a) shift+click to place and/or move the selected landmark, or 

b) use the X, Y, or Z number fields to move the selected landmark’s 
location. 

2. When satisfied with sensor positions, click UUppddaattee. 

Also: 

 Landmark points that contain electrodes provide their 
corresponding sensor number. For instance, the left neck 
landmark point is identified as sensor #102. 

 To return a mark to its default position, click the RReesseett  sseelleeccttiioonn 
button. 

 To undo the last action, click the UUnnddoo  sseelleeccttiioonn button.  

 

3. When satisfied with your changes, click Update. 

4. Next, verify the sensors and adjust the landmarks, if needed.  

a) Click Sensors. 

b) Review all sensors in more than one camera image. 

 Ensure there are no sensors on the ears. 

 Look carefully to ensure there are no sensors tucked 
in behind the ears. 

c) If adjustments are needed, click Landmarks. 

d) Make landmark adjustments.  

e) When satisfied with your changes, click Update. 

Continue working between the Landmarks and Sensors windows 
until the sensors on the 3D head model the exactly match the 
sensors in the 2D net application photos. Remember to click 
Update to save changes. 
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➑ When satisfied with changes, click Next to specify conductivities. 

➒ The default 
conductivity values 
that appear are 
based on the most 
up-to-date values 
suggested by 
literature and EGI’s 
own work.  

 

You may change any of the defaults, if desired. Before doing so, 
however, you should have the knowledge to do so prudently. 
To revert back to the MIP’s default values (at any time before 
clicking Create Job), click Default. 

➓ Click Create job.  

When complete, your working directory will contain: 

 Folder with the 3D sensor positions file (.sfp or .gpsr) 
 Folder with the prefix you assigned in step ➍ containing: 

 anatomy.egia 
 geometry.egig 
 JobName.zip 

 Folder named “internal_data”  

Now, go to chapter 10, for lead field generation. 
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9. Creating IHMs 
Creating individual head models (IHMs) takes only about 90 minutes, 
and the MIP steps you through the process. See Figure 9-1. You can 
complete the anatomical processing portion on the same computer 
that is running Net Station Review. This workflow accepts .egia MRI 
scan files and solved sensor position files (.sfp files from GeoScan or 
.gpsr files from GPS). 

Note that an individual solved sensor position file (.sfp or .gpsr) is not required for 
the IHM workflow. You can use one of the built-in averaged sensor position files. 
However, be aware that these averaged files are not ideal for IHMs.  

After you complete this processing, you will generate the lead field 
matrix using the GPU-accelerated computer (chapter 10). 

Higher Quality MRI Images 

Be aware that higher quality MRI images will: 

 Determine the quality of the IHMs created by the MIP. 

 Require less manual editing during MIP processing.  

To ensure that your MRI images are optimized for head modeling, see 
Appendix A (MRI Scanning Guidelines) and/or contact EGI Technical 
Support (Table P-2). 
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Figure 9-1. Stages 1 – 3 of the IHM workflow 
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9.1 Preparing MRI Files with OsiriX MD  
Before you create an individual 
head model with the MIP software, 
you need to format your MRI files 
and locate them in a specific 
directory.  

You format your files by running 
them through OsiriX MD, which 
was included with your MIP 
purchase. 

You locate your files in a working 
directory, which is a folder that you 
establish for all of the input data 
files the MIP software will need. 
This is also the folder where the 
MIP’s generated output files will 
be saved. 

Note that once you start processing, you 
cannot change the location for the output files. 

➊ Create a folder to be your working directory for the following: 

 3D sensor positions file (.sfp or .gpsr) 
 MRI scan files (.egia)  

➋ Ensure that you are using a supported version of OsiriX MD to 
convert your MR images. Using an unsupported version will cause 
the resulting .egia file to be suspended with a warning message.  

If you have any questions, contact EGI Technical Support (Table P-2). 

Where the MIP and OsiriX MD 
applications are installed on your 
local hard drive: 

MIP software  
Location: Applications/EGI/MIP 

OsiriX MD software  
Location: Users/<username>/ 
Library/Applications 
Support/OsiriX MD 

OsiriX MD plug-ins  
Accessed from within the open 
application.  
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➌ Convert the MR images to the necessary .egia format. 

1. Load the MR file(s) into OsiriX MD by dragging 
the archive of raw MR data onto the OsiriX MD 
icon in the Mac’s Dock. 

2. Wait for the MR data to automatically load 
into OsiriX MD. 

➍ When the OsiriX MD window opens: 

 Notice the series of thumbnails. 

 T1 MPRAGE (or equivalent) image files are required, and one’s 
with the most head coverage are highly recommended.  

For structural imaging requirements, see Appendix A. If you 
have any questions, contact EGI Technical Support (Table P-2). 

 Double-click to select that thumbnail.  



GeoSource 3 Research User Manual  |  8103101-54  2017-05-16  |  FOR RESEARCH USE ONLY 93

➎ After the MR image loads, click the MR image to unlock and make 
all features in the OsiriX MD window available.  

If needed, this will also allow you to verify the patient information 
appended to the file. 

➏ From the menu bar, click Plugins > Image Filters > EGI Anatomy 
XML Exporter.  

➐ From this plug-in, export the anatomy files in the .egia format to 
your working directory: 

1. With or without editing the Subject ID. 

Remember that the subject ID must be identical in all files (.mff, .sfp or .gpsr, 
.egia, .gsrc, and, if later using GTEN 100 Research, .mcb) used in the 
workflow. 

2. Typing an appropriate file name. 
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3. And clicking Save. 

 

 

➑ Ensure that you are saving the .egia file to your working directory. 

➒ Ensure that the Resample to 1x1x1 mm field is checked. 

➓ Click Close to quit OsiriX MD. 

a) 

b) 

c) 
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9.2 Setup Before Stage 1  
Before beginning with stage 1 (tissue segmentation), you need to set 
up the MRI scan and atlas CT files. 

➊ Launch MIP from Finder/Applications/EGI/MIP/. 

➋ Select Create IHM From 
Individual MRI, for a 
IHM head model, 
requiring a .egia file.

 

Note that the Load Existing Head Model option is used for reviewing a completed 
head model or resuming the processing of an incomplete head model. 

➌ Browse to select the 
.egia MRI scan file to 
use in creating the 
head model.  

 

➍ Type a prefix to append 
to the output file.  

This is required. 

 

➎ One of the six built-in atlas  
CT head models will be 
preselected based on the 
closest age and gender to  
that in the .egia file. You can, 
however, reselect another.  
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Male pediatric atlas – 0 to 2 years 
Male pediatric atlas – 2 to 9 years 
Female pediatric atlas – 9 to 18 years 

Male adult atlas – 32 years 
Male adult atlas – 40 years 
Female adult atlas – 45 years 

This CT atlas will warp to your MRI scan and give more accurate 
bone structure to your head model. 

The Set Talairach Landmarks window will appear next. You will be 
required to set the Talairach landmarks before continuing. 

➏ With the Set Talairach Landmarks window, you will perform a 
Talairach transformation on the MR data by providing the 
software with three needed anatomical points.  
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CAUTION: Carefully mark the Talairach landmarks. This early step will 
significantly affect all later processing. 

1. Click Edit. This activates the editing tools. 

2. Click the AC button and then click the anterior commissure 
(AC).

You want to mark the tiny peak of the teardrop that hangs 
down under the lateral ventricle and corpus callosum. 

Note that visibility will depend upon the quality of the MRI slices. 
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3. Click the PC button and then click the posterior commissure 
(PC).  

You want to mark the upper leftmost tip of the tube-like 
cylinder that sits on top of the pons and left of the hindbrain. 

4. Click the MP button and then click the point that sits 
equidistant between the AC and PC and occupies the 
hemispheric divide.  
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5. When done with edits, unclick Edit (to exit the editing mode), 
and then click Next (to accept and process changes made 
thus far). 

6. In the panes of the Transformed Image tab, review how the MR 
image has realigned to the Talairach landmarks compared to 
the original image. 

If there are no changes, click Next. 

If there are changes under either tab (Original image or 
Transformed image): 

a) Click Edit (to enter editing mode). 

b) Make changes. 

c) Click Update. 

d) Deselect Edit (to exit editing mode). 

e) Click Next. 

Notice that the MR image is tilted slightly forward after realignment.
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7. Wait until the MIP completes its processing and color overlays 
are showing on the MRI images. 

 

The processing results in a tissue overlay being applied to 
each slice of the MRI. After stage 1 (tissue segmentation), 
every voxel in the MRI images will be designated as one of the 
seven tissue types. 

The quality of MR images affects the MIP’s processing of the 
seven tissue types. High-quality MR images are interpreted fairly 
precisely. Lower quality MR images will require some correction. 
Stage 1 (tissue segmentation) is the user’s opportunity to review 
and edit, if needed, this processing of the MR images. 

9.3 Stage 1—Tissue Segmentation 
The segmentation stage will step you through the brain, WM (white 
matter), GM (grey matter), scalp, and eyeball tissues. You will have 
opportunities along the way to double-check your work before 
proceeding. 
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➊ Get familiar with your viewing options:  

Intensity sliders 

 Top slider controls the minimum intensity threshold. 
 Middle slider controls the maximum intensity threshold. 

Example of slices with a minimum intensity of 0.00 (top slider) and a 
maximum intensity of 96.90 (middle slider). 

Edit bar. Activates and controls editing.

Segmentation bar.
Work left to right (brain 
to eyeballs) to carry 
changes forward. 

MR views (sagittal, 
coronal, and axial).
Press the 1, 2, and 3
number keys to 
make that view the 
active (large) view. 

Slider bars.
Navigate 
through the 
slices of each 
MR view. 

Use the  and 
 arrows to 

navigate one 
slice at a time. 

Status, Back, Help, and Next

(top) min. intensity 
(middle) max. intensity 
(bottom) overlay opacity 
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Overlay Opacity slider (bottom slider) 

Example of slices with an overlay opacity of 0.18. 

Example of slices with an overlay opacity of 0.79. 

➋ Review Initial Brain Segmentation and make edits, if needed. 

The MIP will open at the first 
module (Initial Brain 
Segmentation). See Brain 
activated in the bottom bar.  

To review and edit: 

1. Click Edit. 

2. Specify any changes to be 
made in the fields of the upper bar. 

Click Change, then change the From and To to reclassify 
inaccurate tissue labeling or segmentation, if necessary. 
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The following example changes Background (From) to Grey 
matter (To), while editing the frontal lobe. Clicking and dragging 
fills GM into the areas that the tissue mask missed. 

 

 

3. Whether you made edits or not: 

 To accept tissue edits and move to the next tissue type: 
unclick Edit, click Update, and click Yes. 

 To reject edits: unclick Edit, then click Undo All. 

 If you accidently clicked Next: and inadvertently moved 
to the next tissue module, click Back and wait for the file 
to reload. 

 If you made no edits: simply select the next tissue module’s 
tab. You do not need to click Update. 

 To accept edits for ALL tissue types: unclick Edit, click 
Next, and click Yes.  

Clicking Next and 
Yes saves all 
edits/changes to 
the file so that they 
apply to all stages 
of processing. 
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Anonymizing Scalp Data 

The first time you click Next, a prompt will appear asking if you 
want to anonymize the scalp data. This is your opportunity to 
de-identify the patient/subject by removing identifying facial 
features. 

Clicking Yes  
will smooth 

(anonymize) the 
scalp data  
to remove 

identifying facial 
features. 

 
Clicking No  

will not smooth 
(anonymize) the scalp 

data, so will retain 
identifying facial features. 
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➌ Click the WM tab to review WM segmentation and make edits, 
if needed.  

You will rarely, if ever, need to edit the properly proportioned right 
and left hemispheres. If you do, make sure that you unclick Edit and 
click Update to process the changes before proceeding. 

                  

➍ Click the GM tab to review GM segmentation and make edits, 
if needed.  

Similarly to the 
white matter, you 
will rarely, if ever, 
need to edit the 
grey matter. You 
should, however, 
review how the 
various tissues 
separate between 
the hemispheres. If 
you need to make 
any edits, make 
sure that you unclick  
Edit and click Update to process the changes before proceeding.  



106 GeoSource 3 Research User Manual  |  8103101-54  2017-05-16  |  FOR RESEARCH USE ONLY

➎ Click the Scalp tab to review Scalp segmentation and make edits, 
if needed. 

1. Make changes in one view and double-check them in the other 
two views. Always verify in all three views (sagittal, coronal, 
and axial). 

2. Delete spacers and scalp artifacts. 

3. Also clean up any bumps or ridges left behind after deleting 
spacers and scalp artifacts. 

4. When done with edits, unclick Edit and click Update. 
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➏ Click the Eyeball tab to review Eyeball segmentation and make 
edits, if needed. 

To correctly place the eye tissue, you 
must position and size the eyeballs.  

1. Locate the center of the eyeballs 
in all three views: sagittal, coronal, 
and axial. The center can be 
incorrect in one view, despite 
looking correct in another.  

2. Resize the radius of the eyeballs 
such that they fill the ocular 
cavities completely.  

3. When done with edits, unclick Edit and click Update. 

➐ Before continuing with stage 2 (cortical surface extraction), verify 
the tissue types reviewed and/or edited thus far in the skull 
registration process.  

Use the intensity and overlay opacity sliders, along with the 
crosshairs to move through the slices. 

1. The viewer looks at soft tissues first. Review the reconstructed 
grey and white matter for possible additional edits.  

For example, in this image the grey matter seems incomplete. 
Therefore, return to GM segmentation to verify this area. 
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2. Click the Scalp tab to review the scalp reconstruction. 

If you find anything that requires verification or editing, click 
the Back button to return to the scalp mesh.  

3. If you found nothing to go back to verify or edit, then click 
Next and Yes.
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4. Click the Brain tab to preview the 3D brain. 

If you find anything that requires verification or editing, click 
the Back button to return to the scalp mesh.  

5. If you found nothing to go back to verify or edit, then click 
Next and Yes. 

The software has now completed the skull registration.  

In the next stage you will be reconstructing the cortical surface 
and creating the dipoles. 
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9.4 Stage 2—Cortical Surface Extraction 
Stage 2 carries on from where skull registration left off—it creates 
dipoles on a reconstructed cortical surface. 

The MIP’s masks will automatically remove most unnecessary dipoles. 
In this section, however, you will verify and, if necessary, edit some 
dipoles. More or less editing may be required for the different tissue 
types, depending upon the quality of the MRI images. 

➊ After the software has created 
the surface reconstruction, set 
the number of dipoles (2,400 
or 4,800) to be created for 
your head model.  

Note that you have two trade-offs: 

 More dipoles add more precision for small sources, whereas fewer 
dipoles may be sufficient for larger sources. 

 More dipoles provide higher resolution, whereas fewer dipoles calculate 
quicker. 

➋ A 3D model opens 
showing all of the 
dipoles created. The 
dipole arrows show 
their orientation to the 
cortical surface.  

Note that the bottom blue 
status bar says the MIP is at 
step 8 of 11 and that the 
window now provides the 
Dipoles and Dipoles Image buttons. 
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➌ If you change your mind about the number of dipoles you want, 
click the desired radio button and click Update. 

➍ Click Dipoles image to see the MRI slices. 

➎ Use the intensity and opacity sliders to evaluate the dipoles: 

 Verify dipoles in each slice. 

 Verify that all dipoles are in the cortical grey matter. 

 Verify that all dipoles are properly categorized. 
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 Verify dipoles in each view (sagittal, coronal, and axial) to 
ensure that all dipoles are verified. 

Same dipole in all 
three slice views 



114 GeoSource 3 Research User Manual  |  8103101-54  2017-05-16  |  FOR RESEARCH USE ONLY

Examples of erroneous dipoles that need deleting: 

Optic nerves. It is common for erroneous dipoles to be found on the optic 
nerves in the hemispheric divide (posterior to the eyes). Delete most of 
these, except those that are anterior enough to be relevant.

  

 

 

Delete 

Delete 

Delete 

Do not delete. 
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Rhombencephalon (hindbrain). Look for dipoles that border where the 
spine seems to merge with the brain. The hindbrain and midbrain should 
not display dipoles. The cerebellum is less critical. An isolated patch of 
GM showing a dipole should be deleted. However, do not delete a dipole 
from a section of GM, if, for example, it extends rostrally from the 
cerebrum. If unsure, do not delete. 

 

 

Ventricles. Verify that the mask automatically removed all dipoles from the 
ventricle area in all views (sagittal, coronal, and axial).  

 

 

If a dipole is isolated 
in a patch of GM, 
delete the dipole. 
Verify by navigating 
up through slices. 

Delete 

No dipoles should be 
in the optic nerve area. 
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➏ To delete dipoles that are misplaced: 

1. Click Edit. 

2. Set From to Dipole and To to Background. 

3. Click the dipole.  

Borderline dipole 
not completely in GM: 

optional to retain 
 or delete 

Cursor over dipole
highlights dipole 

Dipole clicked 
 and deleted 

Button bar:  
Edit 
From 
To 
Undo 
Redo 
Undo All 
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➐ When done with all edits: 

1. Unclick Edit. 

2. Click Next.  

The software will now 
complete the dipole 
creation.  

In the next stage, you will 
be transforming the Talairach landmark coordinates and loading 
the sensors. 

9.5 Stage 3—Sensor Registration 
Stage 3 carries on from where dipole creation left off—after transforming 
the Talairach, it will load the sensors and specify the conductivities. The 
goal of this stage is to verify the placement of sensors on the 3D head 
model (in the left pane) against the 2D photos (in the right pane). 

➊ When the head modeling from the 
previous stage is complete, you are 
automatically presented with a 
dialog for selecting your sensor 
positions file.  

1. Select Individual Sensors in 
the Select sensors field. Or, if 
preferred, select a built-in averaged sensor position file. 

Note that an individual solved sensor position file (.sfp or .gpsr) is not 
required for the IHM workflow. You can use one of the built-in averaged 
sensor position files. However, be aware that these averaged files are not 
ideal for IHMs.  
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2. If you selected Individual Sensors, browse to select your .sfp or 
.gpsr file. 

3. The path to that file will 
autofill in the Sensors file 
field.  

4. In most cases, retain the 
autofilled Output file prefix; 
this is the working directory 
you specified earlier. 
However, if you are  
registering another net to an existing head model, you will 
want to specify a separate directory. 

5. You will be 
prompted to 
proceed or not, 
depending upon 
whether you can confirm that the subject ID in the .sfp GPS file 
is the same (or not) as that in the MRI file. 

Select the option that applies. 

Note that the software cannot confirm the subject ID inside the .sfp file. 

Remember that the subject ID must be identical in all files (.mff, .sfp or .gpsr, 
.egia, .gsrc, and, if later using GTEN 100 Research, .mcb) used in the 
workflow. 
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➋ Wait for the GPS sensor registration window to open. It opens with 
the Landmarks view active. 

You will work between this window’s two views (Landmarks and 
Sensors) to manually place the landmark points, and then ensure that 
the sensors on the 3D head model (left pane) are placed exactly as in 
the net application photos (right pane). 

 

Navigation in the 3D and 2D panes: 

 Using the keyboard shortcut mappings (see section 4.4). 

 Selecting a camera in the GPS camera view field. 

➌ First, manually place the seven landmark points on the head model:

1. Click Landmarks, if it is not already the active view. 

Sensors view 

Landmarks view 
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2. Place each of the seven landmark points  (nasion, left PA, right 
PA, left face, right face, left neck, and right neck) on the head 
model as they appear in the 2D net application photos. You 
can either:  

 Click the radio button of one of the seven landmarks, then 
either: 

 shift+click to place and/or move the selected landmark, or 

 use the X, Y, or Z number fields to move the selected 
landmark’s location. 

Notice that landmarks that contain electrodes provide their 
corresponding sensor number. 

 Click the Reset selection button to return a mark to its 
default position. 

 Click the Undo selection button to undo the last action.  

3. When satisfied with your changes, click Update. 
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➍ Next, verify the sensors and adjust them, if needed. 

You cannot move individual sensors. You will adjust the sensors 
across the head via the seven landmark points. When you move 
these landmark points, all sensors will move around the head. 

1. Click Sensors. 

2. Review all sensors in more than one camera image. 

 Ensure there are no sensors on the ears. 

 Look carefully to ensure there are no sensors tucked in 
behind the ears that are not actually there. 

3. If adjustments are needed, click Landmarks. 

4. Make landmark adjustments. You can: 

 Click the radio button of one of the seven landmarks, then 
either: 

 shift+click to place and/or move the selected landmark, or 

 use the X, Y, or Z number fields to move the selected 
landmark’s location. 

Notice that landmarks that contain electrodes provide their 
corresponding sensor number. 

5. When satisfied with your changes, click Update. 

6. Click Sensors and verify the affects of the landmark 
adjustments on the sensor positions.  

7. Repeat steps 3 through 6 until the sensors in the 3D head model 
exactly match the sensors in the 2D net application photos. 

8. Enter the nasion-inion distance, if you have it. If you do not, 
the software will use the Cz from the atlas CT scan. 

9. When satisfied with changes, click Next. 

The Specify Conductivities dialog will appear next. 
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Example: 

After clicking Landmarks, making adjustments, then clicking Sensors to 
review, we see that adjustments have resulted in a sensor appearing on the 
ear, even though most other sensors are better positioned. By going back into 
Landmarks and making another adjustment to the closest landmark points 
(and updating the file), we can remove the sensor from the ear.  

Always verify each adjustment before moving on.  

 

The above landmarks affect the below misplaced sensor on the ear. 
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➎ Wait for the specify conductivities dialog to appear. 

1. Unless you have 
specific conductivity 
values, retain the 
default values. 

2. Enter your working 
directory name in the 
Job Name field. 

3. Click Create Job.  

This will create a 
bundled zip file containing the components of your head 
model. 

4. You will be 
prompted to 
proceed or not, 
depending upon 
whether you can confirm that the subject ID in the .sfp GPS file 
is the same (or not) as that in the MRI file. 

Note that the software cannot confirm the subject ID inside the .sfp file. 

Select the option that applies. 

5. Click Yes to 
quit MIP. 

Now, go to chapter 10, for lead field matrix generation. 
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10. Stage 4—
Generating the LFM 

You will generate your lead field matrix (LFM) for all CAHMs and IHMs 
using the EGI GPU-accelerated computer, not the EGI Mac computer.  

You will need the following files: 

 The .zip or .xml file of a completed CAHM or IHM. 

 Optionally, a .gpsr file for the completed CAHM or IHM.  

➊ Double-click the JAR icon to launch the 
Electric Head Model Generator.  

➋ Wait for the Electric 
Head Model 
Generation dialog 
to open.  
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➌ Click Select or drag and drop the .zip file of the completed head 
model from your working directory into the Input File field of the 
Electric Head Model Generation dialog. 

Fields automatically  
populated: 

 Subject Name 

 Model Type 

 Local Path for Result 

 Conductivity Values 

 EGIG 

 

*Clicking Select allows you to change related fields. 

➍ If you used a .gpsr file of the completed head model, click Select 
or drag and drop the .gpsr file from your working directory into 
the GPSR field of the Electric Head Model Generation dialog.  

 

 

This field can be left blank, however, if no .gpsr file was used. 

If you completed your head model using an .sfp sensor position file, 
you will not use that file here, because .sfp files do not contain photos. 
Therefore, leave this field blank. 
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➎ Enter the name or IP 
address of the GPU 
computer being used into 
the GPU Node field.  

➏ Enter the name for the user account in the Account User Name field.  

➐ Notice that all 
required fields 
are now filled.  

➑ If needed,  
click Select  
to change 
associated 
fields.  

➒ With required fields filled in correctly, 
click Run.  

➓ Enter your EGI account password and  
click Generate.  

LFM processing will take about 25 – 45 minutes, depending upon the 
channel count used with the head model. 
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When processing is complete, the output will be a .gsrc file, which can 
be opened in the RVE for use with the GTEN 100 Research system for 
neuromodulation planning.  

Your working directory now contains the following files: 

 .gsrc completed head model bundle, including: 
 LFM output 
 egia anatomy file 
 .egig geometry file 

 .zip file, including LFM inputs 

 .sfp or .gpsr sensor position file 
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Appendix A: 
MRI Scanning Guidelines 
For the generation of individual head models (IHMs), EGI: 

 Requires T1 MPRAGE (or equivalent) image files. 

 Highly recommends image files with the most head coverage. 

Following are EGI’s guidelines for suitably scanning the anatomical 
structures that are needed for the creation of electrical head models. 

Image Requirements 
Adhere to the following image requirements to ensure the proper 
generation of your electrical head models. 

 
Good image: good tissue contrast, whole head coverage, low noise, and minimal distortion 
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Good tissue contrast:  

The gray and white matter should be easily distinguished.  

If the contrast resolution is poor, the segmenting software may 
confuse the tissue types.  

We recommend a T1 scan using a sequence similar to Siemen’s 
MPRAGE (or GE’s SPGR) with a 1X1X1 mm resolution.  
(The scanning direction is not important.) 

Whole head scan (not just whole brain):  

The structural T1 scan should cover the entire head and extend 
about 4 cm below the chin.  

The cheek and upper neck regions need to be included in the 
MRI scans to coincide with the EEG electrodes in those same 
areas that will be registered when generating the head model.  

Low Noise:  

The T1 should: 

 look crisp  
 be an accurate description of the subject’s head geometry 
 be low in noise 
 be low in distortion 

 show all identifiable anatomical features (nose, mouth, 
eyes, forehead) 

Minimal Scalp Distortion:  

Nothing should be used during scanning that will distort the 
scalp surface. The scanned head surface must match the head 
surface during EEG acquisition.  
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The subject should: 

 not wear headphones, but instead use ear plugs 

 not wear the EEG sensor net 
 not have excessive padding around the head 
 not be positioned such that the scalp is squished, 

stretched, wrinkled, or otherwise distorted 

 
Poor image: wearing head phones depressed the skin and scalp around the ears 
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Examples of Poor Imaging 

Poor Coverage 

 
Poor image: The jaw and neck region is missing and the crown of the scalp is distorted. 

In the above image, there are two conditions that prevent it from 
being usable for accurately registering all of the EEG sensors that 
are required for generating an electrical head model. 

1. The cheek and face sensors are missing.  

2. The crown of the scalp is distorted. 
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Poor Contrast 

 
Poor image: The contrast is too low to clearly distinguish tissues. 

  
Poor image: The contrast is too high to clearly distinguish tissues. 

In the above images, the blacks and whites are either too dark 
in the low contract image or too bright in the high contrast 
image in order to easily differentiate white matter from gray 
matter.  
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Poor Distortion 

 
Poor image: Facial features (nose, eyes, mouth, teeth, chin, and forehead) are missing. 

Along with the inclusion of the cheeks, jaw, and neck, all 
anatomical features must be intact for the MRI to be useful in 
generating an electrical head model. 
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